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Preface

This manual explains how to install, configure, and use MacSPIRS v4.0.

Using this Manual

This manual is available in PDF format so you can view it in Adobe

Acrobat Reader. You can print the document, or use it online. If you use
it online you can click on a Table of Contents entry, or a cross-reference,

to move to the relevant text.

Some Conventions used in this Manual

These are the conventions used throughout this manual:

Example

Describes

Isproot/bin

pkgadd

filename

filename

root

This bold type indicates a filename, or a URL.

This typeface indicates text as you would type i,
or an example of how it appears on the screen.

This bold type indicates a placeholder, when in-
cluded in something you type. You substitute the
text appropriate to your system.

This italic type indicates a placeholder, when de-
scribed in the text.

This italic type indicates an account name.

(Sheet 1 of 2)



Example

Describes

File

[Enter]

This bold type indicates a menu, menu option, or
the name of a button on the screen.

It is also used for command names.

This bold type inside [ and ] indicates a key on
your keyboard. Note: if the instructions say “En-
ter...” this means type in the text as instructed,
(substituting your text for any placeholders) and
press the [Enter] key.

(Sheet 2 of 2)




Chapter 1

Before You Begin

What is in this
Manual?

1-1

Introduction

SilverPlatter databases are organized collections of records. Each record
represents an article, book, bibliographic citation, etc. Records are
divided into categories of information known as “fields,” such as title,
author, etc.

MacSPIRS, the SilverPlatter Information Retrieval System for the
Macintosh, lets you search SilverPlatter databases and display, print, or
save the retrieved records. You can also save your search strategy to use
again in later sessions.

Before you begin working with MacSPIRS, you should be familiar with
general Macintosh techniques, such as using the mouse and Option
button, and resizing windows. This guide uses standard Macintosh
terminology (“mouse,” “window,” etc.) and only discusses Macintosh
utilities when they interact with MacSPIRS commands. If you are not
familiar with the Apple Macintosh, we recommend that you read through
its documentation before using MacSPIRS.

Listed below are brief descriptions of the contents of this manual

Read... If you are... It will tell you...

Chapter2  Responsible for installing How to get the software,
MacSPIRS and install and configure it.

Chapter 3 A MacSPIRS user How to use the different
MacSPIRS screens

(Sheet 1 of 2)
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Introduction

Read...

If you are...

It will tell you...

Chapter 4

Chapter 5

Chapter 6

A MacSPIRS user

A MacSPIRS user

A MacSPIRS user

How to search using Mac-
SPIRS

How to use the records you
find: marking, sorting,
printing, and downloading
records, and changing var-
ious options.

An alphabetical list of
menu items and buttons.

(Sheet 2 of 2)
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Contacting SilverPlatter

To learn more about SilverPlatter software, or if you have any queries
about installing and running the ERL Server software, please do one of
the following:

Email our Technical Support staff:
support@silverplatter.com

Call your SilverPlatter distributor, or one of the following
SilverPlatter Technical Support teams:

* For the Americas, Japan, Australia, and the Pacific:
Boston Office:

Tel: 1-781-769-2599
1-800-343-0064 (US/Canada)
Fax: 1-781-769-8763

* For Europe, Africa, Middle East, and South Asia:
London Office:

Tel: +44 (0)181-585-6400
0800-262-096 (UK)

Fax: +44 (0)181-585-6640

Amsterdam Office:

Tel: +31 (0) 20 6259650

Fax: +31 (0) 20 6237408

Berlin Office:

Tel: +49 30-85 77 99-0

Fax: +49 30-85 77 99-99

* For Asia:

Hong Kong Office

Tel: 8522529 0356

Fax: 8522804 2746

Access the SilverPlatter website:
www.silverplatter.com



1-4 Introduction



Chapter 2

2-1

Installing MacSPIRS

This chapter provides details on installing MacSPIRS. It is divided into
the following sections.

+ Ifyou have an earlier version of MacSPIRS

*  Hardware and Software Requirements

* Installing MacSPIRS

*  Network Installation Instructions

*  Configuring MacSPIRS

*  Making MacSPIRS Your Startup Application

*  Setting Interface Preferences

If You Have an Earlier Version of MacSPIRS

If you have MacSPIRS 2.2 installed, MacSPIRS ignores that earlier
version. You cannot re-use the configuration files from the earlier
version, and we recommend that you delete the old Overrides folder from
the System folder.

If you have MacSPIRS 2.4, and the Overrides folder is in the Preferences
folder in the System folder, we recommend you make a backup of your
macspirs.ini file. MacSPIRS asks if you want to retain your existing
macspirs.ini during installation. We recommend you say “no” so that
you will install a new file, with all the additional 4.0 features. If you
make a backup of the old file, you can use that to restore any settings you
have made in the previous version that are still relevant in 4.0.
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Checking Hardware and Software Requirements

Before you start to install the software you must check the hardware
requirements for your platform.

For the very latest information about hardware requirements, please see
the SilverPlatter web site at:
http://www.silverplatter.com/erl/ericlientreq.htm

Note: MacSPIRS requires the System 7 operating system, or later.

Installing MacSPIRS

Running the Installer

Below are the steps for installing MacSPIRS. Help is available on each
of the installation screens.

Note: During the installation, some anti-virus programs like Vaccine,
SAM, and GateKeeper may notify you that code resources are being
modified. If this occurs, you may need to turn off the anti-virus program
to complete the MacSPIRS installation.

The instructions for running the MacSPIRS Installer depend on whether
you are running it from SilverPlatter’s FTP site, or the Software
Resource CD. Please call our Technical Support staff if you cannot
access the software using these methods.

From SilverPlatter’s FTP Site

The SilverPlatter FTP site contains all of the current ERL and SPIRS
software, as well as beta versions of future releases. If you have FTP
capabilities, you can download MacSPIRS 4.0.

Note: MacSPIRS is distributed via FTP in BinHex format. The archive
file (macspirs.sea.hqx) must be un-BinHexed before you can extract
the MacSPIRS files. Certain Macintosh FTP utilities, like Fetch, will do
this automatically during the download process. Refer to your FTP
software documentation for more information.

1. Using Fetch (or a comparable FTP utility), access SilverPlatter’s
site at ftp.silverplatter.com.

2. Ifnecessary, login as anonymous and provide your email address as
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your password.

Change directories to software/erl-clients/maci/.

Download and un-BinHex macspirs.sea.hqgx.

Once downloading is complete, double-click on MacSPIRS.sea.

At the introductory screen, click Continue.

N o o M W

Select an existing folder or name a new folder in which to place the
MacSPIRS files.

Click Save.

©

9. A message appears when the MacSPIRS files are extracted. Click
Quit to exit the archive.

10. Double-click on the SP Installer 4.0 icon to begin the installation.
From the Software Resource CD
SilverPlatter regularly distributes its current ERL and SPIRS software on

the “SilverPlatter Software Resource CD”. If you have a copy of the
Resource CD, follow the instructions below.

1. Open the MacSPIRS 4.0 folder on the Resource CD.
2. Double-click on the SP Installer 4.0 icon to begin the installation.

There are three types of MacSPIRS installations, as described below.

To select a type of installation:
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Select the installation you want to perform.

MacSPIRS Installer SilverPlatter Software
Copyright (C) SilverPlatter International NY. 1998

What do you want to do? (Click @ for help)

@ Full Installation
() Reconfigure Installed Application

(2 Preconfigure Defaults

o =7

FIGURE 2-1 The Installation Type dialog box

*  Click Full Installation to install a new MacSPIRS application
or to replace a previous version of MacSPIRS.

* Click Reconfigure Installed Application to change the
software options of an existing MacSPIRS application.

« Ifavailable, click Preconfigure Defaults to sct ERL
(Electronic Reference Library) login options. This modifies the
Installer for future installations.

Note: If you select this installation option, some of the follow-
ing steps do not apply. See the ERL Administrator s Manual
available at the SilverPlatter ftp site, for example at:
ftp:/iftp.silverplatter.com/software/erl-server/solaris/

for additional information.

Click OK.
If you selected the Full Installation option, MacSPIRS displays the
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User License dialog box.

Subscription & License Agreement

English

EEEEEEEEEE

IMPORTANT - - You are about to download, install or use
SilverPlatter's proprietary software for conducting searches
of Databases.

IT gou want to print this license agreement, click the "Print
Agreement” button.

By clicking the "Accept” button, you agree to be bound by the
following license, and you represent that you are authorized
to accept on behalf of the Customer.

[«]

HAccept]l [Decline] [PrintAgreement] Yarsioh:

FIGURE 2-2 The User License dialog box

If necessary, click the Version pop-up menu to change between
other language versions of the License Agreement.

Click Print Agreement to print a copy of the User License
Agreement.

Click Accept to accept the license agreement and continue the
installation.

Click Decline to cancel the installation.

If you chose the Full Installation or Reconfigure Installed Application
option, you are asked to name the new application or locate the
application you want to modify.

1. Identify the MacSPIRS application:

If you selected Full Installation, identify the drive and folder in
which to create the new MacSPIRS application, and provide a
name for the new application.

Ifyou selected Reconfigure Installed Application, identify the
drive and folder in which the MacSPIRS application to modify
exists, and indicate the name of the application.

2. Click Save.
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Selecting an
Application Type

Select an
application type

Specify ERL

The next step in the installation process involves selecting the type of
application and installation code you want to install through the
Application Type dialog box. If you are installing or modifying a
MacSPIRS ERL client, you can also specify the servers you want to
access.

MacSPIRS Installer : Application Type

Select the type of application you want:
” > Standalone Only
@ ERL Client Only

() Both (Client & standalone)

Select the
_ @FATbinary O 68K O Native PPC Only |——f— type of
installation
Server Address (1) [ Next ] code
123.12.12.123 :

Server
information

[ Add Server ][ Edit ][ Delete Server ]

Switch CFG file

7

FIGURE 2-3 The Application Type dialog box

1. Ifyou are performing a full installation or reconfiguring an existing
application, select the application type:

« Click Standalone Only for an application that can access
databases on local drives and networks only. Select Standalone
Only if your Macintosh will not be connected to an ERL server.

*  Click ERL Client Only if your Macintosh will be connected to
an ERL server but not to a local network or CD-ROM drive.

*  Click Both (Client & standalone) if your Macintosh will be
connected to an ERL server and one or more local networks or
CD-ROM drives.

2. Select the type of code you want to install:

*  Click FAT Binary for a version of MacSPIRS that will run as a
native application on either a 68K or PowerPC machine. This
version requires more disk space than the other versions.

*  Click 68K for a version of MacSPIRS that will run as a native
application on a 68K machine, or under emulation on a
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PowerPC machine. (Note: Performance may be slower on a
PowerPC.)

*  Click Native PPC Only for the PowerPC version of MacSPIRS.

Note: These options are only available if you are performing a full
installation. Refer to “Selecting a Type of Installation” on page 2—3
for more information.

Note: If you try to run the Native PPC version on a 68K machine by
mistake, the installation will succeed, but you will see an error mes-
sage when you try to run MacSPIRS.

If you chose the ERL Client Only or Both (Client & standalone)
application type in step 1, you can add, edit, or delete ERL server
addresses.

Note: The ERL server addresses you enter are stored in the ERL
Configuration (erlcInt.cfg) file in the MacSPIRS Overrides folder.
If you want to use the server addresses from an existing erlcint.cfg
file, click Switch CFG file and sclect the appropriate file.

To add a server address:
1. Click Add Server.

2. Enter the server’s IP address or host name in the Add Server
dialog box.

3. Click OK.
To edit a server address:

1. Ifnecessary, click Next to display the server address you want
to edit.

2. Click Edit.

3. Modify the server’s IP address or host name in the Edit Server
dialog box.

4. Click OK in the Edit Server dialog box.
To delete a server address:

1. Ifnecessary, click Next to display the server address you want
to delete.

2. Click Delete Server.
3. Click OK in the Delete Server dialog box.
Click OK in the Application Type dialog box to continue the
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Selecting Software
Options

installation.

The MacSPIRS software options, explained below, determine how
MacSPIRS will operate. These options are available if you are installing
MacSPIRS for the first time or reconfiguring an existing application.

To select software options:

1. Inthe Software Options dialog box, click on the option settings you
prefer, and type in data where required.

MacSPIRS Installer : Software Options
@ Printable records: @ all ) Maximum Number [ |

Allow userto exchange databases: @ Yes ) No

Automatic restart: @ None (3 Timeout (minutes) [ |

Update Magnetic Files @ Yes (O No

Allow Simultaneous Users 3 Yes @ No

POPOO P

Allow 5DIs @ Yes {3 No

o g

FIGURE 2-4 The Software Options dialog box
2. Click OK.
Printable records
Specify a maximum number of records that users can print, or accept the
default that All records can be printed. If users try to exceed the limit you
set, they will be given the option of printing the limited number of
records or none at all.
Allow user to exchange databases
Indicate whether users can switch databases without leaving MacSPIRS.

If you click Yes, the Exchange Databases command in the File menu
is available to users; if you click No, the command is unavailable.
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Automatic Restart

You can set up MacSPIRS so that it automatically restarts after a given
period of inactivity. Each time MacSPIRS restarts, the Search History
window is cleared and all options and window characteristics are reset to
their defaults.

+ Ifyou want MacSPIRS to automatically restart after a period of
inactivity, click Timeout (minutes) and type the number of minutes
MacSPIRS should be inactive before restarting.

+ Ifyou do not want MacSPIRS to automatically restart after a period
of inactivity, click None.

Update Magnetic Files

If a MacSPIRS application has already been installed on your Macintosh
and you are reconfiguring it or installing a new one, you have the option
of not updating the MacSPIRS magnetic support files. These files are
unaffected by changes to the software options.

*  Click Yes if you want to reinstall the MacSPIRS magnetic support
files.

*  Click No if you do not want to reinstall the support files.
Allow Simultaneous Users

If you are installing MacSPIRS on a network and want to allow
simultaneous users, click Yes; otherwise, click No to limit MacSPIRS to
one user at a time.

Allow SDIs and Alerts

If you want to let your users user the SDI and Alerts feature, click Yes;
otherwise, click No.

If you choose Yes, you see an additional dialog box, this is described at
“Setting up SDIs and Alerts” on page 2—17.

If you are installing MacSPIRS as an ERL Client Only or Both (Client &
standalone) application, you can preconfigure usernames and
passwords for automatic login to the ERL servers you specified during
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installation. (For more information on specifying server addresses, refer

to “Selecting an Application Type” on page 2—6.)

ERL Auto Login Setup

B

Server
0 #1
O #2
O #3
O #4
O #s

%

Server ID (SP$%..) User ID

Password

) (e

To specify

FIGURE 2-5 The ERL Auto Login Setup dialog box

ERL passwords:

1. Enter the following information for each server you want to access:

« Server ID for each IP address or host name listed in the
Application Type dialog box. Precede each ID with SP$, such
as SPSSERVER1 IDor SP$server?2.

- U

ser ID for each Server ID.

» Password for each Server ID.

Note: You can omit the Server IDs and enter a single User ID and
Password instead. If you do, MacSPIRS will use that User ID and
Password to log on to all the servers you specified in the Application
Type dialog box.

If you want to prompt users for the username and password, leave
the UserID and Password fields blank. If you want to prompt users
for the password only, enter a question mark (?) in the Password

field.

2. Click OK.

Concealing ERL Login Information

After configuring the Installer and verifying your server connections,
you can hide the ERL login information. Doing so allows you to
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distribute a fully configured application without revealing server
information.

To conceal ERL login information:

1.  Complete the installation and run the new MacSPIRS application.

2. Ifyou are satisfied with the server connections, rerun the Installer
and select Preconfigure Defaults.

3. Check the Conceal this Dialog option to hide the ERL Auto Login
Setup dialog box.

4. Click OK.

Whichever of the installation types you have performed, you will see a
message confirming successful installation; click the OK button that
accompanies this message to exit the MacSPIRS Installation program.

Network Installation Instructions

Installing MacSPIRS
on a Novell File Server

Using MacSPIRS in a network environment allows you to search more
than one database at once, and saves you time in that you do not need to
physically change disks each time you want to search a different
database.

You can install MacSPIRS on a Novell file server to make the databases
mounted on the server available to every Macintosh on the Novell
network. Each Macintosh will be able to run MacSPIRS, whether or not
MacSPIRS has been installed on that computer.

To install MacSPIRS on a Novell server:

1. Install MacSPIRS on a Macintosh. Refer to “Installing MacSPIRS”
on page 22 for information.

2. When the installation is complete, move the MacSPIRS Overrides
folder from the Preferences folder in the System folder of your
Macintosh to the folder in which you installed MacSPIRS.

3. Move the entire MacSPIRS folder to the desired volume on the
Novell server. The server must be running NetWare for Macintosh.

4. From aNovell workstation, flag all the MacSPIRS files on the server
as shareable, read only.
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Installing MacSPIRS
on an AppleTalk
Network

If ever you need to update or reconfigure MacSPIRS, you must do so
from a Macintosh.

You can install MacSPIRS on an AppleTalk network so that each
Macintosh in the network can access the databases loaded on the local
drives of every other Macintosh in the network. This installation allows
a user to run MacSPIRS from a remote Macintosh.

To install MacSPIRS on an AppleTalk network:

1. Install MacSPIRS on a Macintosh. Refer to “Installing MacSPIRS”
on page 22 for information.

2. Verify that File Sharing and Program Linking are on.

3. Ateach Macintosh, Share the CD-ROMs to be made available to the
network.

4. At each Macintosh, Duplicate the MacSPIRS application so that
each user runs a different copy of MacSPIRS but shares common
resource files.

Configuring MacSPIRS

Turning Off
Immediate Record
Display

Once MacSPIRS is installed, you can change certain system options,
such as immediate record display, default fields, subdirectory access, and
capitalization of file names through the macspirs.ini file. This file is
located in the MacSPIRS Overrides folder within the Preferences folder
in the System folder.You can also change the default memory
requirements for running MacSPIRS.

For faster searching, you can prevent MacSPIRS from showing records
automatically after each search. To do so, edit the InstantRecords
setting in the Show section of the .ini file as shown below:

[ Show]
| nst ant Recor ds=0

After changing the default, you must click Show Records Found in the
Find Records dialog box or select Show All Records from the Show
menu to view retrieved records. Refer to “Showing Records” on page 5—
1 for more information.
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MacSPIRS allows you to set default fields for showing, printing, and
saving records. You can apply these default fields to all databases or to a
specific database family by editing the UsrFields setting in the .ini
file. For example, to specify TI (Title) and AU (Author) as the default
display fields for all databases, edit the UsrFields setting in the Show
section as shown below:

[ Show]
Usr Fi el ds=TI, AU

MacSPIRS will show these default fields when displaying records from
any database.

To set different default fields for a particular database family, add the
two-letter database family code to the UsrFields setting. For
example, to specify AB (Abstract) as a default field, but only for records
from the MEDLINE (ML) database family, type the following:

[ Show]
Usr Fi el ds=TI, AU
Usr Fi el ds- ML=TI , AU, AB

TI and AU will be the general default fields for all databases. Records
from any MEDLINE database will display the TI, AU, and AB default
fields.

Note: macspirs.ini provides a partial list of database family codes; if the
code you need is not included in this list, contact SilverPlatter.

If your Macintosh is attached to a network, you can configure MacSPIRS
to access databases stored on network directories. To do this, add the
directory name to the appropriate DIRMAP (1, 2, 3, etc.) setting in the
.ini file. (The number of DIRMAP settings will vary according to your
system’s configuration.)

For example, to have MacSPIRS look for a database in “splib,” a
subdirectory of “hd330” on DIRMAP1, edit the setting as shown below.
Make sure there are no spaces in the hard drive name.

Dl RMAP1=hd330: spli b

When you start MacSPIRS again, it will look for databases in the “splib”
subdirectory of “hd330”, as well as any local CD-ROM drives and
accessible ERL servers.
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Standardizing
MacSPIRS File Names

Changing MacSPIRS
Memory
Requirements

If a network directory has multiple subdirectories, use the wildcard
symbol (¥) to automatically locate and map to all databases found in the
subdirectories. For example, to locate databases in the subdirectories of
“1GBDrive:spdb”, edit the setting as shown below:

Dl RVAP2=1GBDr i ve: spdb: *

MacSPIRS will look for databases in all subdirectories of
“1GBDrive:spdb”, as well as any local CD-ROM drives and accessible
ERL servers.

Note: Generally, network subdirectories will contain a single database.
With the exceptions of MEDLINE Express and EMBASE Express,
subdirectory names do not have to match the database’s volume ID.
Consult your system administrator for more information on network
subdirectories.

If you are running MacSPIRS on a case-sensitive server, you can change
all file names to upper or lower case by editing the MAC section of the
macspirs.ini file.

To standardize the case of all MacSPIRS file names, go to the MAC
section in the .ini file and change the ForceCase setting to 1 (for upper
case) or 2 (for lower case) as shown below:

[ MAC]

ForceCase=1

or

[ MAC]
For ceCase=2

By default, the minimum and preferred memory requirements for
MacSPIRS are 2 MB and 4 MB, respectively.

These settings, listed in the MacSPIRS Info dialog box, indicate the
amount of system memory currently needed to run MacSPIRS.
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[0 =—— MacSPIRS Info =—FZ-H

l@l MacSPIRS

Kind: application pragrar
Size: 2.5 ME on dizk (2,583,559 bytes)
Yhere: Macintozh HD:

Created: Tue, Jan 12, 1999, 3:45 pm
Modified: Thu, Feh 18, 1999, 427 pm
Yersion: 4.04, ©3ilverPlatter Information, Ltd

1999
Comments:
..Memory Requirements
i Suggested Size: nda K
¢ MinimumSize: [2000 ] K i
{ PreferredSize: [4000 | K
[ Locked

Mote: Memory requirements will increaze by 1,279k
if wirtual memory is turned off.

FIGURE 2-6 The MacSPIRS Info dialog box

If necessary, you can increase the amount of preferred memory to as
much as 12 MB or reduce it to as little as 2.5 MB.

Note: Reducing the amount of preferred memory is recommended if you
are running MacSPIRS on a machine with 4 MB RAM and experience
system crashes when selecting databases.

Making MacSPIRS the Startup Application

To make MacSPIRS the startup application, use the Set Startup
command in the Special menu of your Macintosh. This command allows
you to run an application automatically when you start your Macintosh.
To dedicate your Macintosh to running MacSPIRS:

1. Arrange your Desktop so that you can see the MacSPIRS icon.

2. Select MacSPIRS by clicking once on the MacSPIRS icon to
highlight it.

3. Select Set Startup from the Special menu.
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4. Click OK.

5. Select Restart from the Special menu.Your Macintosh starts
MacSPIRS automatically.

Setting Interface Preferences

MacSPIRS allows you to set certain interface preferences, including the
color of various display elements, font and font size, and window
positions.

To set interface preferences:

1. Ifnecessary, start MacSPIRS.

2. Select Preferences from the Edit menu. The Preferences dialog box
opens.

Preferences

Colours: [ (set Colour ...

Font: |Gene|.la v|

Font Size

[ save window settings

[ save ]][revert to Defaults| [ Cancel | @

FIGURE 2-7 The Preferences dialog box

3. Change the color and font settings as needed.

4. If you want the main MacSPIRS windows (such as the Retrieved
Records window) to always open in their current positions, check
the Save window settings box.

5. Click Save.

Your settings are saved in the MacSPIRS Preferences file in the
Preferences folder.

To change back to the original default settings:
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1. Select Preferences from the Edit menu.
2.  When the Preferences dialog box opens, click Revert to Defaults.

3. Click Save. MacSPIRS returns all color, font, and window options
to their default settings.

Setting up SilverLinker

MacSPIRS 4.0 includes support for the SilverLinker database, which
provides links from bibliographic records to the full text of articles in
electronic journals to which your library subscribes.

The SilverLinker database contains URL links from articles. These links
are displayed dynamically within SilverLinker-enabled bibliographic
databases. The links appear as hotlinks in a separate field with the short
name FTXT and link directly to the website where the full text article is
located.

The FTXT field must be set to display, so that users will see the
SilverLinker links. See “Setting Default Fields” on page 2—13 for details
of how to set default fields for displaying records.

SilverLinker full-text links are displayed only when the SilverLinker
database, and your SilverPlatter bibliographic databases, are installed on
ERL dbserver 4.0. They are not available if MacSPIRS is installed
locally. In addition, your institution must have subscriptions to electronic
journals at the web site or sites that host the full text.

For more information about SilverLinker see the ERL Administrator’s
Manual available at the SilverPlatter ftp site, for example at:
ftp://ftp.silverplatter.com/software/erl-server/solaris/.

Setting up SDIs and Alerts

Links to WebSPIRS
for SDIs

In libraries that have the WebSPIRS 4.0 or later (4+) gateway installed,
you can link MacSPIRS 4.0 to WebSPIRS so that authorized users can
access the SDI (Selective Dissemination of Information) current
awareness search feature.
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Configuring
MacSPIRS to Allow
SDIs and Alerts

The SDI feature lets users save and identify searches to be rerun
automatically. The user specifies the interval at which they want the
search to be rerun along with the email address to which search results
are to be returned.

With WebSPIRS 4.1, the Alert feature is also available: authorized users
can subscribe to a selection of searches prepared by the administrator or
librarian. These searches are run periodically, and the results emailed to
the user.

You must have the following components to take advantage of these
features:

*  An account on a WebSPIRS 4+ server and an internet or intranet
connection and its URL to access WebSPIRS 4+.

« A browser: Netscape 3.01 or Internet Explorer 4, or later.
*  Access to the databases required for the SDI.

*  Two logins assigned on the ERI Server, for when a user creates or
edits an SDI. This is because the ERL Server treats the contact
between MacSPIRS and WebSPIRS, which takes place through the
Server, as two simultancous Server users: one a MacSPIRS user, and
one a WebSPIRS user. In some circumstances, these two users will
share the same username. For this reason, you should set the
Server’s limit on the number of simultaneous logins for a single
username to two or more.

Note: The databases selected for a MacSPIRS search must be available
on the WebSPIRS server hosting the SDIs.

For information about configuring WebSPIRS for SDIs and Alerts, see
the WebSPIRS Implementor’s Guide, available at the SilverPlatter web
site at http://webspirs.silverplatter.com/ws40docs/

You give or restrict access to the SDI feature using the MacSPIRS 4.0
software option: Allow SDIs. You can do this if you are installing
MacSPIRS for the first time or reconfiguring an existing application.
To setup the SDI feature:

1. Use the Installer to access the Software Options dialog box. (See
“Selecting Software Options” on page 2-8.)

2. Check Allow SDiIs to display the SDI Setup dialog box.
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MacSPIRS Installer : SDI Setup

WebSPIRS Address :

SDI User ID: ‘ ‘

SDI Password : ‘ ‘

@ [[ox ) [(cancer)

FIGURE 2-8 The SDI Setup dialog box

Enter the URL for WebSPIRS.

Enter a username and password, if you want to.

Note: MacSPIRS creates a reference to the browser used to access
the SDI feature the first time a user uses the feature. If you replace a
user’s browser, MacSPIRS will still try to open the previous brows-
er, and will fail. To avoid this, you must delete the user’s MacSPIRS
preferences file. MacSPIRS will create a new file when the user
opens MacSPIRS, and will create the reference to the new browser
when the user first uses the SDI feature. You may want to make a
backup of the preferences file, and edit the new file to retain any ear-

lier preferences.

Click OK to close the SDI Setup dialog box.
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SDI Menu Items

Creating an SDI and
Subscribing to an
Alert

MacSPIRS 4.0 contains new File menu items that function with the SDI
feature. The following menu items appear only after MacSPIRS has been
configured to enable the SDI feature.

Use this File Menu Item To do this

Save As SDI Set up an SDI. After conducting a
search and choosing this menu item,
MacSPIRS 4 links automatically to
WebSPIRS and displays the Create
SDI screen.

Show SDI Account Edit or administer existing SDIs by link-
ing to WebSPIRS to view an account
users set up previously.

Alert Services... View and subscribe to alerts by linking
to WebSPIRS 4.1 or later.

SDI Set up... View and edit the settings to access
WebSPIRS.

For instructions on how your users create SDIs, and subscribe to Alerts,
see “Creating an SDI from MacSPIRS” on page 4-27 and “Subscribing
to an Alert” on page 4-32.

Providing Library Holdings Information

About the Holdings
Conversion Utility
(HCU)

The Holdings Conversion Utility (HCU) lets you display local holdings
information about SilverPlatter bibliographic databases.

HCU converts a library’s serials holdings file (in ASCII or MARC
format) into a SilverPlatter formatted file which, when installed on a
server or stand-alone system, can be used to display local holdings
information along with SilverPlatter bibliographic records. HCU-
generated files support the display of holdings information within any
ISSN-based SilverPlatter database. HCU can be installed on either a
Windows 32-bit platform or a UNIX platform.



About SPLHA

Making Holdings
Information Available

Disabling Holdings
for Specific
Databases
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MacSPIRS 4.0 supports library holdings for all databases supported by
the Holdings Conversion Utility (HCU).

If users have a browser running on a MacSPIRS 4.0 workstation,
MacSPIRS also supports holdings messages with embedded URLs.
(Earlier versions of MacSPIRS do not support URLs embedded in
holdings messages.)

For details of how to create library holdings information, see the
Holdings documentation available at SilverPlatter’s ftp site, for example
at: ftp://ftp.silverplatter.com/software/hcu/solaris/.

MacSPIRS 4.0 will continue to support files generated by the earlier
utility: SilverPlatter Library Holdings Administration (SPLHA)
However, MacSPIRS 4.0 does not support both formats simultaneously.
Your holdings must be in either the SPLHA format or converted to the
new holdings format.

To make holdings information available:

* Ifyou are using files generated by the Holdings Conversion Utility
(splha.lhd, splha.lhi, and splha.lhm), put these three files into the
MacSPIRS Overrides folder.

+ Ifyou are using files generated by the earlier SPLHA utility, put the
two files (.Imh and .Ihd) into the MacSPIRS Overrides folder.

Ifthese files are installed, MacSPIRS shows additional fields in retrieved
records. These fields display information about the local holdings, if that
information is available.

The additional fields are *LHM and *LHC. These fields must be set to
display so that users will see the holdings messages. See “Setting Default
Fields” on page 2—13 for details of how to set default fields for showing
records.

See “Default Holdings Messages” on page 2—22 for details of how to
configure MacSPIRS to display default messages if holdings information
is not available.

MacSPIRS 4.0 lets you exclude holdings information for specific
databases. If you do this, holdings messages do not appear in records
from the databases you specify. This mechanism applies only to locally
mounted databases. Records from databases accessed using an ERL
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Default Holdings
Messages

server will still show holdings messages, unless holdings from these
databases are disabled at the ERL server.

To disable a database from displaying holdings messages:

1. Open macspirs.ini in a text editor.

2. Go to the first section, which starts with [ ].

3. Findtag ! 42. Delete the semi-colon (; ) at the beginning of the tag.
(This makes the tag active.)

4. Enter acomma-delimited list of the database families for which you
do not want holdings messages to display.

The default is for holdings messages to display for all SilverPlatter
databases. If you explicitly list in this file some subset of your data-
bases for which holdings message display is disabled, holdings mes-
sages will display only for those database families you have not
included in the list.

For example:
If your library subscribes to the following databases:

*  Medline Advanced (MEDS)

*  Psyclnfo (PY)

*  Sociofile (SO)

+  Cinahl (NU)

you might want holdings messages to display on/y for Medline

Advanced and PsyclInfo. So you add the following to macspirs.ini:
142=S0,NU

Note: You must enter the database family names, and you must separate
each with a comma.

An example line appears in macspirs.ini, commented out by an initial
semicolon.

You can enable the display of default holdings messages for situations
when MacSPIRS cannot identify a message to display from your HCU-
generated holdings file. The most common occurrence of this would be
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for journals that your library does not subscribe to, although other
circumstances might also cause this.

Note: This mechanism applies only to locally mounted databases.
Records from databases accessed using an ERL server will not show
these messages. A similar mechanism is available for configuring an
ERL server to provide default messages. See the ERL Administrator s
Manual available at the SilverPlatter ftp site, for example at:
ftp:/iftp.silverplatter.com/software/erl-server/solaris/

for details.

The macspirs.ini file contains a list of numeric tags and text messages
associated with various conditions that result in no holdings information
being available for display:

;150=Hol dings files missing or inconplete

;151=Hol dings files have no conpati bl e keys

;152=Hol dings for this database fam |y disabl ed
;153=No hol dings key field in record

; 154=No hol dings key found in field

; 155=The holdings key in this record is invalid

;1 56=Hol di ngs index file corrupt - rebuild

;157=No hol dings information for this record

You specify which of these messages you want to display, and you can
change the text displayed.

To change the default holdings messages:

1. For any condition for which you would like a default message to
display, open the macspirs.ini file in your text editor.

2. Delete the semi-colon (; ) at the beginning of the tag which
corresponds to the condition for which you would like a default
message to display.

You can leave the text as it is, or edit the text to display any wording
you wish. If messages span multiple lines, you must type \n at the
end of each separate line of text at the point where you wish the line-
break. If you press [Enter] at the end of a line, the message will be
truncated at that point.

For example:

If you want to display a message for journals that your library does
not subscribe to, locate tag ! 57 and delete the semi-colon (; ). You
might want to replace the default text :
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No hol dings information for this record

with appropriate text such as :

The library does not subscribe to this\n
journal. Please ask library staff\n
for help in getting this article.



Chapter 3 MacSPIRS Basics

This chapter introduces you to the basics of MacSPIRS, including:

+  Starting MacSPIRS

*  Selecting a database to search
*  Finding and showing records
*  Using the Index

*  Using the Thesaurus

*  Getting online help

* Ending a search session

This chapter assumes that MacSPIRS has been installed on your
computer. See Chapter 2, “Installing MacSPIRS” if necessary.

Starting MacSPIRS

To start MacSPIRS, double-click on the MacSPIRS icon in the folder in
which it was installed. To make MacSPIRS more accessible, you may
want to make an alias for MacSPIRS and drag it to your desktop or the
Apple Menu Items folder. If necessary, refer to the Macintosh
documentation for information on the Apple menu and making aliases.

After you launch MacSPIRS, you can select the database(s) you want to
search.
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Selecting a Database

When you start MacSPIRS, it displays a database title screen or database
selection screen, depending on how many databases are available.

If only one database is If only one database is available, MacSPIRS automatically displays the

available database title screen as shown below. This screen provides the coverage
dates, scope, and copyright information for the current database. The title
screen disappears once you perform a search.

MEDLINE {R) Advanced
National Library of Medicine
1995/05-1995/09

The use of this database and SilverPlatter's proprietary search-and-retrieval software is
governed by the SilverPlatter License Agreement. The text of this license can be viewed in
English, French, German, Italian, Portuguese and Spanish at SilverPlatter's website,
http:d S 51 lver platter com/Micense himl, or by selecting "License Agqreement” under
the Apple menu. By clicking an the "Start Search’ button or otherwise starting a search,
yau agree to the terms of this license. & Custamer's manually signed license agreement, if
applicable, will supersede any conflicting terms in this license.
This database may cantain links to other sites. SilverPlatter Information has no control
over, and is not responsible for, the content found on external sites that do not belong to
the Silwver Platter group of companies. Links to such sites do not constitute Silver Platter's
spansorship, endorsement ar approval of the content on these sites, and Silver Platter
disclaims Tiability for such content.

MEDLIME R} Adwanced is based on MEDLINE (R}, the National Library of Medicine's
bibliographic database. Some material in this database is from copyrighted publications
of the respective copyright claimants, Users of the database are referred to the
publication data appearing in the bibliographic citations, as well as to the copyright
notices appearing in the original publication, a1l of which are hereby incor porated by
reference.

Type a search request, then click the Start Search button.

Kl

FIGURE 3-1 The Database Title screen

If multiple databases If multiple databases are available, MacSPIRS displays the database

are available selection list. Depending on the source and type of available databases,
this list includes the server name (for network databases), database
names, and coverage dates (if available). A separate text area below the
selection list displays any available information about the currently
highlighted database.
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MacSPIRS v 4.0
Select the databases required and press 'return’

Ll ¥ieie Felte iove

CC Search{R) Life/Clin Ed. 1998/710724-1998/10/30
s CC Search{R) Life/Clin Ed. 1998/707701-1998/10/30

MEDLINE {R) Advanced 1996-1997

MEDLINE (R} Advanced 1994- 1995

MEDLINE (R} Advanced 1992-1993

MEDLINE {R} Advanced 1990-1991

MEDLINE (R} Advanced 1988- 1989

MEDLINE (R} Advanced 1986- 1987

MEDLINE (R} Advanced 1979-1982

MEDLINE {R) Advanced 1974- 1978
1 b=

ServerInfo:sp (53] wh [w]

0K |] (_clear Selections | [Refresh | [ Eect | [_quit | @

SilverPlatter Software Copyright (C) SilverPlatter International NY. 1999

MG

FIGURE 3-2 The Database Selection screen

To select databases from the list:

1.

Click on the title of each database you want to select. A check mark
appears to the left of each selected title. Alternatively, you can use
the arrow keys to move the highlight bar through the list and press
[Enter] to select titles.

If necessary, click Clear Selections to clear all database selections.
You can also click Refresh to update the selection list after
removing or loading databases.

Click OK. MacSPIRS displays the first database title screen and the
Title Screen dialog box shown below. (You only see this screen if
you select more than one database.)

Title Screph"—"—————————

” Find Records ]| [ Next Title Screen ] [ Previous Title Screen ] a

FIGURE 3-3 The Title Screen dialog box

Click Next Title Screen and Previous Title Screen to view the
remaining title screens.

Click Find Records to open the Find Records dialog box and begin
your search.
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Exchanging
Databases

If the Allow users to exchange databases option is enabled during
MacSPIRS installation, you can change the databases you want to search.
(Refer to “Selecting Software Options” on page 2—8 for more
information on the Allow users to exchange databases option.)

The procedure for exchanging databases differs depending on whether
you are working with a single CD-ROM drive or with multiple CD-ROM
drives and/or database servers.

Exchanging Databases in a Single-Drive System

To exchange databases on a Macintosh that has one CD-ROM drive:

1. Select Exchange Databases from the File menu. MacSPIRS
displays the database selection screen.

2. Click on the name of the database to remove and click Eject.
3.  Remove the disc containing the old database and insert the new disc.

4. Click on the name of the new database in the database selection
window and click OK.

Exchanging Databases in a Multiple-Drive System

To exchange databases on a Macintosh that has multiple CD-ROM
drives and/or is networked to a database server:

1. Select Exchange Databases from the File menu. MacSPIRS
displays the database selection window.

2. From the database selection window, you can select a database that
is already loaded or replace a local database with a new one.

*  Toselect a different database that is already loaded, click on the
name of the database and click OK.

*  To replace a database loaded on a local CD-ROM drive, click
on the name of the database and click Eject (the button is only
active when a local database is highlighted.) Replace the old
disc with the disc containing the new database, click on the
name of the new database, and click OK.

Note: If you exchange databases, your search history is retained,
allowing you to reuse any of the searches on the new database.
MacSPIRS displays a message in the Search History window that reads
“Searches above from:” and is followed by the title of the database you
removed. To reuse a search, hold down the Option key and highlight the
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text of the search. MacSPIRS retypes the search in the Find Records
dialog box, so that you can use it to search in the new database.

SilverPlatter v 4.0 - Search History =—iaoo=—" g B
Current Database: CC Search{R} Life/Clin Ed. =
Mo Records Search Request
#1 331 hiatus
*2 5053 hernia
#3 105 hiatus hernia
Searches abowve fram Group of Databases:2
#4 Z51 hernia
[~
4] D7

FIGURE 3-4 Reusing a search on a new database

For more information on search histories, refer to “Using the Search
History” on page 4-21.
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MacSPIRS at a Glance

Finding and Showing
Records

The following sections illustrate key MacSPIRS components and the
basic flow of the search process. The examples show you how to find and
show records as well as use the Index and Thesaurus.

Once you select a database, MacSPIRS displays the database title screen
and Find Records dialog box. The Find Records dialog box is where you
type terms to search for in the database. MacSPIRS displays the results
in the Search History window and the records containing your search
term in the Retrieved Records window.
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(1) 2]

SilverPlatter v4.0 - Search History HE
Type a search term MacSPIRS
yP . . displ Current Database: MEDLINE {R) Advanced =
or phrase in the Find Isplays your Mo Records Search Request
Records dialog box search request, ——
. i)
and click Start Search. ~ and any #2 33393 pressure
previous ) #3 13104 blood pressure
requests, in the
Search History =

Find Records

Enter search: Combine terms using: [in]

* |IJIDD|:I pressure | *
(start Search) [Show Records Found) [ Thesaurus | [Suggest] [Erase]

©

MacSPIRS displays
your search results in Display of Search #3 : blood pressure

Retrieved Records

the Retrieved Records 10f 34892
window. - Effects of postmenopausal estrogensprogestin replacement therapy
. n LOL particles; comparison of transdermal and oral treatment
reqimens,
AlU: Lahdenpera-5; Punlakka-.J; Pyorala-T; Luotola-H; Taskinen- MR
H AD: Departrment of Medicine, University of Helsinki, Finland.

Click on any record 50: Atherosclerosiz. 1996 May; 122(2): 153-62

number to select 155N 0021-9150

records for showing, PY: 1996

printing, or saving. La- EroLol

AB: The aim of the study was to compare the effects of continuous oral
estrogen/progestin therapy to the effects of transdermal estrogen

i| therapy combined with cyclic oral progestin on the properties of LDL
particles. Eighty postrenopausal women were randomly allocated to
receive either oral {continuous 17-beta-estradiol 2 mg and
norethisterone acetate 1 mg per day, E2/NETAD or transdermal therapy
¢ patches delivering continuous 17-beta-estradiol, E2, 0.05 myg/day
with sequential oral medroxyprogesterone acetate, MPA, 10 mgdday for

< [

0 Show Records

Click Next [ Nest Record | [ selectFields | Selected Records
Record and <: - [ﬁ
Previous [ Previous Record | [ show subset | Find Records @

Record, or use
the scroll bar in
the Retrieved Records window,
to view retrieved records.

Refer to “Using the Find Records Dialog Box” on page 4-2 and
“Showing Records” on page 5—1 for more information on finding and
showing records.
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Using the Index

Select Browse
Index from the

Search menu. —»

©

The Index lists all of the searchable terms in the database, and indicates
the number of records that contain each term. In addition to the Free Text
Index, some databases have separate indexes for certain fields such as

Title or Author.

As shown in the following example, the Index is especially useful for

looking up hyphenated phrases.

Search
Find Records ... #F
Browse Inded ... 1

Select Index ...
Clear Searches ...

Hide Intermediate Results

(2]

If the database you are searching has more
than one Index, MacSPIRS displays the List
of Available Indexes window. Click on the
short name of each index you want to select
and click OK.

Lateral Search #=

MacSPIRS displays the
Index window and the
Browse Index dialog box.

ECI==——— Index

Records  Terms

12519 PROTEIN
PROTEIN-

PROTEIN-&
PROTEIMN-A-ELUTED
PROTEIN-ACTIVATED
PROTEIN-ACTIVATING
PROTEIN-ADENYLATE
PROTEIN-AG-GOLD-COMPLEX
PROTEIN-ALPHA
PROTEIN-ALTERING

List of Available Indexes
Select the index(es) you require

~ *F FREE TEXT
155N INTERMATIONAL STANDARD SERIAL NUME .
P PUBLICATION YEAR
LA LANGUAGE OF ARTICLE
cP COUNTRY OF PUBLICATION
TG CHECKTAGS
FT FUBLICATION TYPE
AN MEDLINE ACCESSION NUMBER
un UPDATE CODE
5B SUBSET
Al ABSTRACT INDICATOR

Bty
24

o

F

Browse Index

Type a term or

Current Index: FREE TEHT

phrase at the

Change Index

Look Up: | PROTEIN

Look Up:

(Browse Index] [ Search ]

prompt and
click Browse

|
(Thesaurus] [ Erase ]e

Jo— o i — — o — o P — @R

w
(=1
— 0

PROTEIN-BASED

PROTEIMN-EINDING \

PROTEIN-BINDING-DRUG-EFFECTS ]

Index.I

]

=

Refer to “Using the Index” on page 4—12 for more information on using

the Index.
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Using the Thesaurus Many SilverPlatter databases include a Thesaurus, which is a list of
controlled vocabulary terms used to standardize the indexing in the
database. You can use the Thesaurus to select and search for synonyms,
related terms, and preferred terms.

Select Browse
Thesaurus from —»
the Thesaurus

menu.

Thesaurus
Browse Thesaurus ...
St Bebad g Term
Shieris Seiadied Tree

HT

(2]

Enter a word: Type a search term
or phrase in the
* |KIDNEV Browse Thesaurus

| =
[ Browse Thesaurus | 0 dialog box and click

Browse Thesaurus.

A |
© =

. . KIDNEY {continued)
MacSPIRS displays the List Kidney

Browse Thesaurus

List of Permuted Terms

of Permuted Terms and the Kidney, Artificial

Permuted Terms dialog Kidney Eean Lectins: See Phytohemagglutinins

box. Kidney-GBrush-Border Meutral Proteinase: See Membrane Metallo-Endope
Kidney Calculi

Click on any term to search Kidney Calices

for it, add it to a list of terms Kidney Circulation: See Renal Circulation

Kidney Collecting Ducts: See Kidney Tubules, Collecting
Kidney Concentrating Ability

Kidney Cortes

Kidney Cortex Necrosis

Kidney, Cystic

Kidney Diseases

Kidney Failure

e Kidney Failure, Acute

for batch searching, or get
term detalils.

Permuted Terms

Click Enter @ Explode Term — _
another word single T s h Term Details

to look up > single Term Searc fdd to List

another term Enter another word
using the
Browse The-
saurus dialog
box.

L

Refer to “Using the Thesaurus” on page 4—15 for more information on
using the Thesaurus.
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Getting Online Help

There are several kinds of help available in MacSPIRS. Context sensitive
help provides information on specific elements of MacSPIRS. The Help
menu provides general information on using MacSPIRS as well as
specific help on the loaded database(s).

Context Sensitive Context sensitive help offers assistance on specific elements of
Help MacSPIRS, such as buttons, dialog boxes, and menu items.
To use context sensitive help:

1. Click the Help icon near the bottom right of most dialog boxes. The
arrow pointer changes to a question mark.

2. Click on the item you want to find out about. MacSPIRS displays an
explanation of the item.

[0 =—————Help on NEAR
Click the ? icon to leave Help.

iz
| m

Click mear to place the operator after a search term, before
specifying another. Using mear retrieves records containing
both of two terms in the same sentence. For example,
Syelexis negr chiFdretrieves anly records containing
"dyslexia” and "child” in the same sentence. Either termcan
appear first.

You can add a number to near to specify how close together
the terms must be. For example, compader pegr3
Aardwsrefinds the two terms within three words of each
ather inthe same sentence.

&4

4] [»

FIGURE 3-5 A typical context sensitive help window

3. Continue to click on other items as necessary for additional help.

4. Click the Help icon again or click the help window’s close box to
leave Context Sensitive Help and recover the arrow pointer.

Menu Help The Help menu provides information on search techniques, the loaded
database(s), and how to use the help system.

To use the Help menu:
1. Select a topic or subtopic from the Help menu:

* Help on SilverPlatter Help instructs how to use the Help menu.
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MacSPIRS Help Topics offers general advice on using
MacSPIRS.

MacSPIRS Help Keywords lists the key words and phrases
used in the MacSPIRS Help Topics.

List Databases and Fields displays a list of all databases and
fields currently in use. (For more information, refer to
“Database and Field Information” on page 3—12.)

Guide Topics provides a list of Help topics for the loaded
database(s).

Guide Fields lists the fields contained in the loaded database(s).

Guide Keywords lists the key words and phrases used in the
Guide Topics.

MacSPIRS displays the topic you select. If necessary, resize the
Help Window or scroll through the text.

[0 = Running Saved Search Historie = B B

‘ou can re-use saved search histories in
your current search session.

To run a saved search history:

1. Choose Run Search History from the
File menu. MacSPIRS displays a standard
open file dialog.

2. Indicate the name and Tocation of the
saved search history file.

3. Click Open. MacSPIRS runs the search
higtary, and displays the results in the
Search History area.

Hote: ‘Youcan jump-start MacSPIRS with
a saved search history. From the Macintosh
desktop, double-click on a saved search
history; MacSPIRS will start up and run
the searches on the selected databases.

Related Topics:

1

S

[»

FIGURE 3-6 A typical Help window

Click on a link to jump to another topic.

You can return to a previous Help window, provided it is still open,
in the following ways:

Click the close box of the current Help window.

Click on any visible portion of the previous Help window.
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+ Ifabullet () appears to the left of the current Help topic title,
you can hold down the Command key [ # ] and press [B], or
select Previous Topic from the Help menu.

5. Close the Help windows, or leave them open for reference, and
return to what you were doing.

Database and Field Information

At any point during your work session, you can use the List Databases
and Fields menu command to get information on the current database
and fields.

* Select List Databases and Fields from the Help menu. MacSPIRS
displays the Database(s) and Fields window showing all current
databases and their fields. If more than one database is in use, the
fields are divided into Universal Fields (those common to all
databases) and database specific fields. You may need to use the
scroll bars to see all the field names.

[0 =———"Database(s) and Fields BB
Current Database: -
MEDLINE {R} &dvanced 1996-1997
Database Fields {Bold = Limit Field; Italics = Unsearchabley

Tl TITLE

TO ORIGINAL TITLE

CH COMMENTS

Al AUTHOR(S)

Al ADDRESS OF AUTHOR

S0 SOURCE {BIBLIOGRAPHIC CITATION}

JN JOURNAL NAME

LR L idegey Rl ngs Messsge

FLAC L857 Humber

155N INTERMATIOMAL STAMDARD SERIAL NUMEBER

PY PUBLICATION YEAR

L& LANGUAGE OF ARTICLE

CP COUNTRY OF PUELICATION

AB ABSTRACT

MESH MEDICAL SUBJECT HEADINGS [MJME,MIME]

MJME MAJOR MeSH HEADINGS

MIME MINOR MeSH HEADINGS

AGE AGE TAGS

TG CHECKTAGS —

-
[] b %

FIGURE 3-7 Database(s) and Fields window

To use a field name as part of a search request:

*  Hold the Option key and click on the field’s short name; MacSPIRS
places the short name in the Find Records dialog box. (When
searching in a field, always use the field’s short name in your search
request.)
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To get a description of a particular field:

*  Click its full field name. MacSPIRS displays a window containing
an example and brief description of the field. Click this window’s
close box to return to the Database(s) and Fields window.

O ===PT Publication Type =—F B

PT Publication Type -

(alimit field) I=|
Fi=ediforial

clipical-drisl in pt

The PT field indicates the type of
publication fram which the record was
taken.

You can search using the field 1abel or,
alternatively, select publication types from
the PT field-specific indes.

Mote: Use the not operator to search for
records indexed by only the main
publication tupe without the subheadings,
for example: review fo g red
review— ¥

S

4] [»

FIGURE 3-8 A typical field description Help window

Ending a Search Session

Quitting MacSPIRS

Restarting MacSPIRS

When you are finished searching, you can quit MacSPIRS and return to
the Desktop or restart MacSPIRS for the next user.

To quit MacSPIRS, select Quit from the File menu. MacSPIRS clears the
Search History window, restores all options and window sizes to their
defaults, and closes. You return to the Macintosh Desktop.

To restart MacSPIRS, select Restart Session from the File menu.
MacSPIRS restores all options and window sizes to their defaults, and
displays the database selection screen.
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Searching with MacSPIRS

You can search for records in a variety of ways, depending on your
search concepts, the database you are searching, and your preferences.
This chapter illustrates various ways of using the Find Records dialog
box to search databases:

*  Performing a Simple Search

*  Valid Search Statements

*  Using Truncation and Wildcards

»  Searching for Hyphenated Phrases

*  Using Parentheses

*  Combining Terms with Operators

*  Searching in Specific Fields

*  Searching in Limit Fields

*  Using the Suggest Feature

The second part of the chapter addresses some of the more advanced
MacSPIRS functions:

*  Using the Index

*  Using the Thesaurus

»  Using the Search History

*  Using Current Awareness Searches: SDIs and Alerts

*  Searching Multiple Databases

+  Narrowing and Broadening Your Search
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Using the Find Records Dialog Box

Performing a Simple
Search

The first step in a search is to decide what you are searching for. Identify
terms or concepts that describe your search objective. Once you have
your topic, think of the search terms that represent the search topic.

Next, evaluate your search terms in relation to the database: do they
adequately describe the topic? Will they be too specific or too general?
The answers to these questions depend on many factors, including the
scope of the database you choose to search.

Once you identify the objective of your search, you can determine how
to search the database. The simplest way to search is described below.

To search for a term of phrase:

1.

Type a search request in the Find Records dialog box.

Find Records

Enter search: Combine terms using: [in]

4= |h|ood pressure | =5
(start search] [Show Records Found) [ Thesaurus ) [Suggest) [Erase] 0

FIGURE 4-1 Searching for “blood pressure”

Click Start Search. MacSPIRS lists the results of your search in the
Search History window.

SilverPlatter v4.0 - Search History HE

Current Database: MEDLINE (R) Advanced =
Mo, Records Search Request

#1 109512 blood
7 33393 pressure
#3 13104 blood pressure

Z

FIGURE 4-2 Results of the search for “blood pressure”

Note: The results of the individual terms of the phrase (for example,
“blood” and “pressure”) are included if you have the Show Interme-
diate Results option turned on in the Search menu.

Ifnecessary, click Show Records Found in the Find Records dialog
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box. MacSPIRS displays the records retrieved by your search.
I

Retrieved Records
Display of Search #3 : blood pressure

1 of 34892
TI: Effects of postmenopausal estrogen/progestin replacement therapy
on LDL particles; comparizon of transdermal and oral treatment
regimens.
AU: Lahdenpera-5; Puolakka-J; Pyorala-T; Luotola-H; Taskinen- MR
AD: Department of Medicine, University of Helsinki, Finland.
S0: atherosclerosis. 1996 May; 122(2): 153-62
IS5N: 0021-9150
PY: 1996
LA: EMGLISH
CP: [RELAND
&B: The aim of the study was to compare the effects of continuous oral
estrogen/progestin therapy to the effects of transdermal estrogen
therapy combined with cyclic aral progestin on the properties of LDL
particles. Eighty postmenopausal women were randomly allocated o
receive either oral {continuous 17-beta-estradiol 2 mgand
norethisterone acetate 1 mg per day, E2/HETA) or transdermal therapy
{ patches delivering continuous 17- beta-estradiol, E2, 0.05 myg/day
with sequential oral medroxyprogesterane acetate, MP&, 10 mg/day for

bt
o] 0

FIGURE 4-3 Records retrieved by a search for “blood pressure”

Note: The records are displayed automatically if you have the Im-
mediate Record Display option turned on in the Options for Show
dialog box.

Refer to the following sections in this chapter for information on refining
your search. Remember online help is available: click on the help icon in
any dialog box or use the Help menu.

Below are examples of search requests that you can type in the Find
Records dialog box. Each request can be up to 1024 characters long.

Description of Search Example
A term dog

A term with truncation conput *
A term with wildcards col o?r
A number 1994

Letters and numbers combined 3m

(Sheet 1 of 2)
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Using Truncation and
Wildcards

Searching for
Hyphenated Phrases

Description of Search Example
A phrase new york city
A hyphenated phrase drug- abuse

A phrase with operators in quotes “near” death experience
A term or phrase limited to a field smith in au

A previous search request #3
number

Any of the above, combined with  3m and #2
operators

Any of the above, separated by  drug-abuse;#4;smith in au
semi-colons

Any of the above, grouped (canine or #1) near puppy
with parentheses for clarity

(Sheet 2 of 2)

You can retrieve variations of a search term by using truncation and
wildcards. This is a useful means of broadening a search that has
retrieved too few records.

The truncation symbol (*) serves as a substitute for any string of zero or
more characters. For example, type cardio* to retrieve cardiology,
cardiogram, etc.

The wildcard symbol (?) serves as a substitute for one character or none.
For example, type m?cdonald to retrieve McDonald or MacDonald.

The truncation and wildcard symbols can be used anywhere in your
search term, except as the first character.

Often, when a database is set up, the individual words of a phrase are
“bound” with hyphens so that the complete phrase can be indexed, rather
than just the individual words. For example, authors’ names are
hyphenated so that the first and last names are kept together in the Index.
Similarly, controlled vocabulary terms, such as descriptors, are
hyphenated so that key phrases are kept intact.
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When searching a field that uses hyphens, you can include them in or
omit them from your search request to make the search more or less
focused. To determine which fields use hyphens, take note of the fields
in a retrieved record or refer to the database Guide in the Help menu.

Including Hyphens for a Focused Search

If the field you are searching uses hyphens, you can hyphenate your
search term to retrieve only occurrences of that term.

For example, if you are searching the Descriptors (DE) field, the search
request marine—-aquaculture in de retrieves only occurrences

of marine-aquaculture. Similarly, in the Authors (AU) field, the search
lindeman-c in au retrieves only records authored by C. Lindeman.

Alternatively, you can select hyphenated phrases from the Index. Refer
to “Using the Index” on page 4—12 for more information.

Omitting Hyphens for a Broad Search

If the field you are searching uses hyphens, you can omit them from your
search term to retrieve variations of your term. For example, if you are
searching the Descriptors (DE) field, the search requestmarine in de
retrieves occurrences of marine, marine-aquaculture, marine-
crustaceans, marine-environments, etc. Similarly, in the Authors (AU)
field, the search 1indeman in au retrieves records authored by 4.K.
Lindeman, C. Lindeman, C.A. Lindeman, etc.

Use parentheses to avoid ambiguity in complex search statements.

For example, suppose you want to retrieve records that discuss rabies in
dogs or rabies in cats.

The search request rabies and dogs or cats retrieves records
that discuss rabies and dogs, and records that discuss cats, but not
necessarily records that discuss rabies and cats.

The searchrequest rabies and (dogs or cats) retrieves records
that discuss rabies and either dogs or cats, which is what you intended.

If you omit parentheses from a complex search statement, MacSPIRS
automatically inserts them. Check the Search History window to see if
MacSPIRS’ interpretation is what you intended. If it is not, click the
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Combining Terms
with Operators

Break button displayed with the search progress message, and edit the
search request.

Operators are words that have a special meaning in MacSPIRS. You can
use them to combine search terms into a more complex search statement.

Operator What It finds

and Records that contain both of two search terms.

For example, dysl exi a and chi |l d retrieves
records containing both dyslexia and child.

dyslexia child

Shaded area represents records containing the term
dyslexia and the term child

with Records that contain both of two search terms in the
same field.

For example, the search dysl exia with re-
sear ch retrieves records that contain both dyslexia
and research in any one of the database fields.

near Records that contain both of two search terms in the
same sentence.

For example, dysl exi a near treatnment re-
trieves only those records where dyslexia and freat-
ment are in the same sentence (either term can
appear first).

You can add a number to near to specify exactly how
close the terms should be. For example, | anguage

near 2 comnput er retrieves records containing /an-

guage within two words of computer, in any order, in
the same sentence.

(Sheet 1 of 3)
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Operator

What It finds

adj

or

Records that contain two adjacent terms in the order
you specify.

For example, the focus of the search r aci ng bi cy-
cl e is different from that of bi cycl e raci ng. The
adjacent operator means MacSPIRS searches for the
two terms in the order you specify, thus preserving
the focus of your search.

adj also lets you search for identical, adjacent terms,
suchas"gorilla adj gorilla."Thisis useful for
searching biological classifications, in which several
organisms have identical genus and species names,
such as "bufo bufo."

You cannot use adj to combine the current search
with a previous one.

Records that contain either or both of two search
terms.

For example, the search dysl exi a or | earni ng
di sabi li ti es retrieves all records that contain
dyslexia, leaming disabilities, or both dyslexia and
learning disabilities.

dyslexia learning

Shaded areas represent records containing the term
dyslexia or the term learning disabilities

(Sheet 2 of 3)
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Operator What It finds

not Records that contain the first of two search terms, but
not the second. This can be helpful for eliminating
false hits.

For example, t r uman not capot e retrieves
records that contain Truman and do not contain Ca-
pote (references to the president but not the writer.)

not should be used carefully, however, because it
can also eliminate useful records.

For example, if you search fordog not puppy, you
will miss records that discuss both dog and puppy.

relevant records
eliminated

dog puppy

Grey area represents records retrieved by dog not
puppy, Black area represents relevant records elimi-
nated by dog not puppy

(Sheet 3 of 3)

To combine terms with an operator:
1. Enter your first term in the Find Records dialog box.

2. Click the button of the operator you want to use. MacSPIRS places
the operator after your first term.

Find Records

Enter search: Combine terms using: [and] m [not] [in] - [near]
4= |dgs|euia

(Start Search] [Show Records Found) [ Thesaurus | [Suggest] [Erase 0

FIGURE 4-4 Adding an operator to a search request

Alternatively, you can type the operator after your first term.
3. Enter your second term after the operator.

4. Click Start Search.
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Searching in Specific You can narrow your search by limiting it to a particular field or group
Fields of fields in the database. By searching only in relevant fields, you can
eliminate false hits.

For example, suppose you are looking for the works of a particular
author. Rather than search the entire database, you can search only those
fields that contain author information, such as the Author (AU) and
Corporate Author (CA) fields.

To search in a specific field:

1. Inthe Find Records dialog box, type a term or phrase followed by
in and the short name of the field you want to search.

For example, to search for Freud in the Author (AU) field, type
freud in au.

== find ketrdls S"icF -F"——————
Enter search: Combine terms using: [in]
4 [freud in au | m

(start Search) (Show Records Found) [ Thesaurus ) [Suggest] [Erase]

FIGURE 4-5 Searching in the AU field

To search in multiple fields, separate the labels with commas, such
as freud in au, su.

2. Click Start Search.

You can also select field labels from a list and add them to your search:

1. Type a term or phrase in the Find Records dialog box and click the
in button; MacSPIRS displays the Database(s) and Fields window.
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E[J=—— Databasel(s) and Fields
Current Database:

MEDLINE Professional 1957-1991

Database Fields {Eold = Limit Field; talics = Unsearchable)
CITH CITATION [T1,4U,50,L4,4H]

Tl TITLE
Ta ORIGINAL TITLE
C COMMENTS
AUTHOR(S)
ADR ADDRESS OF AUTHOR
S0 SOURCE {BIBLIOGRAPHIC CITATION)

FEN A Fbrsry Meidings Message
A L5 Bumrber
IS5N INTERNATIONAL STANDARD SERIAL NUMBER

PY PUBLICATION YEAR

LA LANGUAGE OF ARTICLE

CP COUNTRY OF PUBLICATION

HE ABSTRACT

= [

FIGURE 4-6 The Database(s) and Fields window

2. Hold down the Option key and click on the short name of the field
you want to search. MacSPIRS places the short name in the Find
Records dialog box.

3. Click Start Search in the Find Records dialog box.

Field-specific indices also provide a way to search particular fields. For
more information, refer to “Using the Index” on page 4—12.

Searching in Limit Limit fields are specially indexed fields that contain relatively few

Fields possible values. They allow you to limit your search results to records of
a particular characteristic, such as language of text or date of
publication.

You can search limit fields with the in or = operator.

For example, if the database you are searching contains a Language (LA)
field, you can retrieve German documents by typing german in la
or la=german.
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Some limit fields, usually those containing numeric information, can also
be searched with the following operators. These allow you to search for
arange of records, such as all records published between 1992 and 1994.

Operator What it Means Search Example
< less than py<1986

> greater than py>1984

<= less than or equal py<=1985

>= greater than or equal py>=1984

- within a range py=1983-1986

To search in a limit field:

1. Inthe Find Records dialog box, type the label of the field you want
to search, such as py.

2. Type = or, if applicable, one of the range operators.

3. Type an appropriate search term. Your search request should
resemble py>1993, an=105899, or la=french.

4. Click Start Search.

For a list of the limit fields in the database you are searching, select List
Databases and Fields or the database Guide from the Help menu.

The Suggest feature, or Automatic Subject Lookup, provides you with a
list of suggested terms related to your search request. These suggested
terms are taken from the database’s controlled vocabulary and appear in
a window that lets you search or display definitions.

Suggested terms are available only with certain SilverPlatter databases,
and only if you are searching a single database. The Suggest button will
not appear in the Find Records dialog box if the feature is unavailable.

To display a list of suggested terms:

1. Type asingle term or phrase in the text entry box of the Find Records
dialog box. (Multiple terms combined with operators or semi-colons
are not allowed.)
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Using the Index

2. Click Suggest. MacSPIRS displays a list of suggested terms.

The following terms from the controlled vocabulary
(thesaurus) may give useful results in a search.
Choose one term to search.

Adenocarcinomal

Antigens,—-Neoplasm
Brain-Neoplasms
Carcinoma,-5Squamous-Cell
Colorectal-Neoplasms
DHA,-Neoplasm
Esophageal-Meoplasms
Gene-Expression
Precancerous-Conditions
Prostatic-Neoplasms
Skin-Diseases

I[ml[ Search ] [I]efinition][ Close ]0

FIGURE 4-7 The Suggestions dialog box

Select a suggested term from the list.

4. Ifyouwantto see a definition for the selected term, click Definition,
then click OK to return to the Suggestions dialog box.

5. Search for the suggested term:
*  Click Explode to search for the term and all narrower terms.

*  Click Search to search for the term without any narrower terms.

The Index lists all the searchable terms in the database and indicates the
number of records that contain each term. Many databases have more
than one index. For example, a database can have an index for the Author
field, and a separate index for the Title field. The Index is especially
useful for finding hyphenated phrases and variations of authors’ names.

Note: Words that appear too frequently to be used in searching are
omitted from the Index; these are called “stopwords” and are listed in the
database Guide in the Help menu.
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To select terms from the Index:

1. Select Browse Index from the Search menu, or hold down the
Command key [ # ] and press [l].

2. Ifthe database contains more than one index, MacSPIRS displays
the List of Available Indexes. For a description of an index, click on
its long name.

List of Available Indexes
Select the index(es) you require

v *F  FREE TEXT
PY¥  PUBLICATION YEAR
LA LANGUAGE OF ARTICLE
CP  COUNTRY OF PUBLICATION
TG  CHECKTAGS
PT  PUBLICATION TYPE
Ul UPDATE CODE
SE  SUBSET
Al ABSTRACT INDICATOR
ol DOCUMENT IDENTIFIER

) 223

FIGURE 4-8 The List of Available Indexes window

3. Click on the short name of each index you want to select and click
OK.

4. MacSPIRS displays the Browse Index dialog box and the Index
window. In the text entry area of the Browse Index dialog box, type
a term or phrase. Use the Erase button to clear any mistakes.

=——— Browse Index
Current Indesx: FREE TEXT [ Change Index |

Look Up: |PROTEIN
(Browse Inden] [ Search ] (Thesaurus] [ Erase ]@

FIGURE 4-9 The Browse Index dialog box

5. Click Browse Index and the term you typed (or its closest
equivalent) appears at the top of the Index window.
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Changing Indexes

ECI=——— Index
Records  Terms

12519 PROTEIN
PROTEIN-

4

g PROTEIN-4

1 PROTEIN-&-ELUTED

2 PROTEIN-ACTIVATED

3 PROTEIN-ACTIVATING

2 PROTEIN-ADENYLATE

1 PROTEIN-AG-GOLD-COMPLEX

1 PROTEIN-ALPHA

1 PROTEIN-ALTERING

1 PROTEIN-ANABOLIC

1 PROTEIN-AMWESTHETIC

1 PROTEIN-ASPARTATE

3 PROTEIN-ASSOCIATED

1 PROTEIM-ATTACHED

1 PROTEIN-B

1 PROTEIN-BARLEY-STRIPE- MOSAIC

4 PROTEIN-BASED

09 PROTEIN-BINDING

31 PROTEIN-BINDING-DRUG-EFFECTS ]

&l B

FIGURE 4-10 The Index window

Browse the Index using the vertical scroll bar. Resize the Index
window or use the horizontal scroll bar to view terms that extend
beyond the right-hand boundary of the Index window.

Select any term or phrase by holding the Option key and clicking on
or dragging across it. MacSPIRS places the selection into the Find
Records dialog box. Multiple entries are connected with the or
operator.

If the database you are using has more than one index, you can change

indexes as follows:

1.

Click Change Index in the Browse Index dialog box or choose
Select Index from the Search menu. MacSPIRS displays the List of
Available Indexes window.

Click on the short name of each index you want to select and click
OK.
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Using the Thesaurus

Looking Up a
Thesaurus Term

Many databases include a thesaurus, which is a list of controlled
vocabulary terms used to standardize the indexing in the database. The
Thesaurus enables you to select and search for synonyms, related terms,
and preferred terms. If the thesaurus is arranged hierarchically, you can
select more general (broader) and more specific (narrower) terms.

Some thesauri provide subheadings that help you to narrow your search.
For example, if you are searching for malaria, you could apply the
subheadings et iology and drug-therapy to make your search
more specific.

Some thesauri allow you to explode your search terms. With this
feature, MacSPIRS searches for records that contain your search term or
any of its narrower terms.

To look up a thesaurus term:

1. Choose Browse Thesaurus from the Thesaurus menu. MacSPIRS
displays the Browse Thesaurus dialog box.

Browse Thesaurus CD88b)b70&@m7—"—"—m—m—m———

Enter a word:
4= [KIDNEY

| =»
[ Browse Thesaurus | 0

FIGURE 4-11 The Browse Thesaurus dialog box

2. Type a word, word root, or phrase to look up and click Browse

Thesaurus. MacSPIRS displays the Permuted Terms dialog box
and list of Permuted Terms, with your term or its closest match
highlighted.
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Getting Details about
a Selected Thesaurus
Term

E[[=—— List of Permuted Terms
KIDNEY (continued)
Kidney
Kidney, Artificial
Kidney Bean Lectins: See Phytohemagglutinins
Kidney-Brush-Border Meutral Proteinase: See Membrane Metallo-Endope
Kidney Calculi
Kidney Calices
Kidney Circulation: See Renal Circulation
Kidney Caollecting Ducts: See Kidney Tubules, Collecting
Kidney Concentrating Ability
Kidney Cortes
Kidney Cortex Necrosis
Kidney, Cystic
Kidney Diseases
Kidney Failure
Kidney Failure, Acute
Kidney Failure, Chronic
Kidney Function Tests
Kidney Glomerulus

o m|

=  PermutedTerms =——_
® Euplode Term Search List Term Details
1 Single Term Search fAdd to List
Enter another word

FIGURE 4-12 The List of Permuted Terms and the Permuted Terms
dialog box

3. Scroll through the List of Permuted Terms. It lists all the descriptor
phrases in which each controlled vocabulary term occurs. You can
get details and search for any terms of interest, and you can add
terms to a list for batch searching.

4. If you need to look up another word, click Enter another word.
MacSPIRS displays the Browse Thesaurus dialog box again.

The MacSPIRS Thesaurus includes a Selected Term Details window,
which provides details about a selected thesaurus term. The information
provided depends on the database you are searching. It often includes a
definition, scope notes, previous indexing terms, and related, broader,
and narrower terms.

To get details about a thesaurus term:

1. Ifnecessary, look up a term in the Thesaurus as described at
“Looking Up a Thesaurus Term” on page 4-15.
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Click on a term in the List of Permuted Terms.

Click Term Details in the Browse Thesaurus or Permuted Terms
dialog box. MacSPIRS displays the Selected Term Details window
and the Selected Term dialog box.

EN=———— selected Term Delais =—T|
SELECTED TERM DETAIL FOR : Kidney
RELATED TERM{S)Diuresis

Nephrectomy

Renal Circulation

Renal Replacement Therapy

TREES: HIERARCHICAL DISPLAY OF IMMEDIATELY BROADER & NARROWER TERMS

TREE 1 of 1: Urogenital System
Urinary Tract
Kidney
Kidney Cortex
Kidney Medulla
Kidney Pelvis (+ 1)
Mephrons (+ 8)

= Selected Term
@ Explode Term (__search List ] [Display Tree)

1 Single Term Search [ fAdd to List ]
i v T - i
[__Search Now ] @

FIGURE 4-13 The Selected Term Details window and Selected Term
dialog box

You can then search for the selected term, add it to a list of selected
terms for batch searching, or display the complete tree.

Displaying Trees

Some thesauri display broader and narrower terms in a hierarchical
structure called a “tree.” Trees are shown in abbreviated form in the
Selected Term Details window.

To display the complete tree:

1.

If necessary, get details about a term as described at “Getting Details
about a Selected Thesaurus Term” on page 4—16.

Click Display Tree in the Selected Term dialog box. If the selected
term appears in more than one tree, you will need to choose the tree
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you want to display from the pop-up list. MacSPIRS displays the
Trees window and Selected Tree dialog box.

E=——— Trees - Hierarchical Display of Terms =——PF|
TREES: HIERARCHICAL DISPLAY OF IMMEDIATELY BROADER & NARROWERLH
SELECTED TERM : Kidney
Tree 1: Urogenital System
Leval

Do Kidney Cortex

L Kidney Medulla

L Kidney Pelvis

S Kidney Calices

L Mephrons

Kidney Glomerulus
..Glomerular Mesangium

B Juxtaglomerular Apparatus
k&
] [o]
Selected Tree
@ Explode Term Search List -
. Term Details
i Single Term Search [ Add to List ]

s 172

View List ]

FIGURE 4-14 The Trees window and Selected Tree dialog box

The column of numbers on the left side of the tree indicates the level of
each term in the tree. Broader, more general terms are indicated by lower
numbers, and are listed further left than narrower, more specific terms.

You can search for any term in the tree, get details on it, or add it to a list.

Searching for
Thesaurus Terms

MacSPIRS allows you to search for thesaurus terms directly from the
Permuted Terms, Selected Term, or Selected Tree dialog boxes. Once

you select a term, you can search for it individually, or you can add it to
a list of selected thesaurus terms for batch searching.

To search for thesaurus terms:

1.

2.

Select any term of interest in the List of Permuted Terms, Selected
Term Details, or Selected Tree window.

Choose the type of search you want to perform:

Select Explode Term to search for the selected term along with
its narrower, more specific terms. This is more comprehensive
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than searching for the term by itself. (If the thesaurus is
organized into trees, you may have to select a tree in which to
explode the term. If there is a pop-up list of trees in the Selected
Term dialog box, select any or all trees.)

*  Select Single Term Search to search for the selected term
without its narrower terms.

Click Search Now to perform the search, or click Add to List to add
it to a list of searches to perform later.

If the thesaurus you are searching uses subheadings, MacSPIRS
displays the Subheadings Selection window. Select one or more
subheadings and click OK. Refer to “Selecting Subheadings” on
page 420 for instructions.

If you chose Search Now, MacSPIRS copies the term, and any
subheadings, to the Find Records dialog box and performs the
search.

If you chose Add to List, MacSPIRS copies the term, and any sub-
headings, to the Selected Thesaurus Terms list. You can then view
the list, add more searches to it, or perform all of the searches.

If You Have a List of Searches

Once you add a search to the Selected Thesaurus Terms list, you can
view the list, add more searches to it, or perform all of the searches.

To view the list:

Click View List in the Permuted Terms, Selected Term, or Selected
Tree dialog box. MacSPIRS displays the Selected Thesaurus Terms
dialog box.



4-20

Searching with MacSPIRS

Selected thesaurus terms - click on a term to mark it for deletion
explode Kidney / Maone

& oxplode Kidney-Diseases / DI
Kidney-Meoplasms ¢ CL

[5>

[ search List ][ close ] (cClear List ] [Delete Selectiuns]@

FIGURE 4-15 The Selected Thesaurus Terms dialog box

To delete searches from the list:

1. Click on each search you want to mark for deletion. MacSPIRS
places a bullet (*) next to your selections.

2. Click Delete Selections.

To perform the searches:

*  Click Search List in the Selected Thesaurus Terms dialog box. (You
can also click Search List in the Permuted Terms, Selected Term,
or Selected Tree dialog box.) MacSPIRS performs all of the searches
and discards the list.

Selecting Subheadings

Subheadings are qualifiers used in some thesauri to describe specific
aspects of terms. If the database uses subheadings, you need to apply one
or more to your term before searching for the term.

To select subheadings:

1. When you click Search Now or Add to List in the Permuted Terms,
Selected Term, or Selected Tree dialog box, MacSPIRS displays the
Subheadings Selection window. (The list of subheadings varies
from database to database.)
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Click on short names to select subheading

All Al Subheadings
None ‘wWithout Subheadings
v A ABNORMALITIES
A ANATOMY AND HISTOLOGY
BS BLOOD SUPPLY
CH CHEMISTRY
CY CYTOLOGY
DE DRUG EFFECTS
EM  EMBRYOLOGY
EN  ENZYMOLOGY
GD  GROWTH AMD DEVELOPMENT
M IMMUNOLOGY

l 0K l Clear Cancel

FIGURE 4-16 The Subheadings Selection window

2. For a description of any subheading, click on its long name.

4-21

3. Click on the short name of each subheading you want to select. You

must select at least one.

4. Click OK.

Using the Search History

The Search History window provides a numbered list of all your search
requests and indicates the number of records retrieved by each. The
Search History is updated with each search request.

SilverPlatter v 4.0 - Search History =— HIBH

Mo,

Current Database: MEDLIME {R) Advanced =

#1
#z
#3
#q

18200 nutrition ar diet

FIGURE 4-17 The Search History window
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Reusing Search
Requests

You can reuse or clear any search from the Search History. You can also
save your history and rerun a previously saved history.

Each of your search requests is numbered and listed in the Search
History window. You can reuse a search request to combine it with a
new search or to show, print, or save the records retrieved by it.

To combine a previous search with a new one:

1.

Hold down the Option key and click on the number of the desired
search request in the Search History window. The number is
automatically placed in the Find Records dialog box.

Alternatively, you can type the number of the desired search request
in the Find Records dialog box, such as #1. (To enter #, press the
Option key, and [3] together.)

Combine the search with additional terms using the available
operators. For example, you could construct a search request, # 1
and freud in au.

Click Start Search. The Search History window reports the number
of records retrieved by the search request.

To show, print, or save the results of a previous search:

1.

Double-click on the desired search in the Search History window.
MacSPIRS performs the search on the currently selected
database(s).

If necessary, select Show All Records from the Show menu.
(MacSPIRS displays the records automatically if you have the
Immediate Record Display option turned on in the Options for
Show dialog box.) Refer to “Showing Records” on page 5-1 for
more information.

To print or save the records, select Print Records or Save Records
from the File menu. Refer to “Printing Records” on page 5—12 and
“Saving Records” on page 5—15 for details.

You can also save all or part of your search history and run the search
requests during later work sessions. Refer to “Saving a Search History”
on page 4-23 for additional information.
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Clearing Search MacSPIRS allows you to remove search requests from the Search
Requests History window. This is useful when you want to start a new set of
searches. Once you have cleared a search request, you cannot recover it.

To clear search requests from Search History window:

1. Select Clear Searches from the Search menu. MacSPIRS displays
the Clear Searches dialog box.

Clear Searches

Enter the searches to be cleared

1-3,5,11

w Cancel 0

FIGURE 4-18 The Clear Searches dialog box
2. Enter the search requests you want to clear. You can enter a single
request, a nonconsecutive group, or a range of requests.

3. Click OK. MacSPIRS renumbers the remaining search requests.

Saving a Search Once you complete a search, you can save any of your search requests

History (search history) and run them during future work sessions. Stored search
histories are especially useful for complex searches, or those you
perform regularly.

To save your search history:

1. Select Save Search History from the File menu. MacSPIRS
displays the Save Search History dialog box.
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Running a Saved
Search History

Save Search History
Enter the searches to be saved:

1-5

Search History Description:

Search on human pituitary hormones.

Startup Database(s) or Family:

||MI_E5,ML* |

(Current Database] [Current Family)

G (oone) @

FIGURE 4-19 The Save Search History dialog box

Enter the numbers for the search requests you want to save. You can
save a single request, a nonconsecutive group, or a range of requests.

Enter a description of the search history.

Enter the startup database(s) or database family you want
MacSPIRS to access when you run the search history. You can type
this information manually, or you can use the Current Database and
Current Family buttons to enter the current codes automatically. If
you want to select databases as normal when you run the search
history, leave this field blank.

Click OK.MacSPIRS displays the standard Macintosh Save dialog
box.

Specify a name and destination for the search history file.

Click Save.

To run a previously saved search history:

1.

Select Run Search History from the File menu. MacSPIRS displays
a standard Macintosh dialog box that allows you to locate your
search history files.

Select the search history file you want to open.

Select Run Saved Searches.
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Click Open. MacSPIRS runs the search against the database(s)
specified in the Save Search History dialog box.

If the specified database is not found, MacSPIRS lets you select
another database from the Database Selection screen.

Note: You can also start MacSPIRS and run a saved search at the
same time. Simply double-click on any search history (.his) file
stored on the hard disk or diskette.

To edit a search history file:

1.

Select Run Search History from the File menu. MacSPIRS displays
a standard Macintosh dialog box that allows you to locate your
search history files.

Select the search history file you want to edit.
Select Show Description/Edit Searches.

Click Open. MacSPIRS displays the Saved Search History dialog
box.

Saved Search History

Search History Description:

Search on human pituitary hormones

Startup Database(s) or Family:

MLES,ML*

[[ i1 ]] [Cancel] [Edit Searches] @

FIGURE 4-20 The Saved Search History dialog box

Edit the Search History Description or Startup information as
needed.

If you want to edit the search requests in the file, click Edit
Searches. The Edit Searches dialog box opens, listing all search
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requests in the history file.

ECI=———— Edit Searches

&>

PITUITARY
HORMOME*

#1 and HORMONE*
HUMAM

#3 and HUMAN

[k ] [ Cancel ]

=
=

FIGURE 4-21 The Edit Searches dialog box

7. Edit the search requests.

Note: MacSPIRS does not check for proper syntax, so if you are un-
familiar with search histories, you should not edit them. In particu-
lar, you cannot edit a search so that it contains implicit, or non-
existent, refer-backs.

8. Click OK to return to the Saved Search History dialog box.

9. Click OK in the Saved Search History dialog box to save your
changes.

Using Current Awareness Searches: SDIs and Alerts

Your MacSPIRS administrator may have set up MacSPIRS in your
organization so that you can use “current awareness searches”. These are
searches that the system runs automatically, at regular intervals, and then
emails the results to you. There are two types of current awareness
searches: SDIs, and Alerts.

With SDIs, (Selective Dissemination of Information) you create and
save your own searches and the system runs them automatically. You
specify the interval at which you want the search to be rerun and give
your email address so that search results are mailed to you. You create an
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Creating an SDI from
MacSPIRS
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SDI search in MacSPIRS, then, when you choose the Save as SDI menu
item, MacSPIRS automatically establishes a link to WebSPIRS, where
you set up the SDI.

With Alerts, authorized users can subscribe to a selection of searches
created by your MacSPIRS administrator or librarian. These searches are
run periodically, and the results emailed to users who have subscribed to
the Alert service.

Ask your MacSPIRS administrator if you are not sure whether you have
access to SDIs or Alerts.

If you have been authorized to use SDIs and Alerts, your MacSPIRS 4.0
screen contains new File menu items that function with the SDI feature.
(These menu items are not available if SDIs have not been authorized.

Use this File Menu Item To do this

Save as SDI Set up an SDI. After conducting a
search and choosing this menu item,
MacSPIRS 4 links automatically to
WebSPIRS and displays the Create
SDI screen.

Show SDI Account Edit or administer existing SDIs by link-
ing to WebSPIRS to view an account
you set up previously.

Alert Service View and subscribe to alerts by linking
to WebSPIRS.
SDI Setup View and edit the settings you use to

access WebSPIRS.

To create an SDI:

Note: The databases you select for a MacSPIRS search must also be
available on the WebSPIRS server that runs the SDIs. Ask your
MacSPIRS administrator if you are unsure about this.

1. Carry out one or more searches in MacSPIRS.

2. Revise your search until it meets your needs for an SDI.
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3. Choose Save as SDI... from the File menu. This launches a browser
connection to WebSPIRS 4.0.

4. Follow the WebSPIRS online help for creating the SDI.

Editing SDI Settings To edit SDI settings:

1. Choose SDI Setup... from the File menu to open the SDI Setup
dialog box.

Dl Setp ="———————— E

WebSPIRS Address |NEtP//WebSPIRSURIl/

User ID |guest |

Password

H 0K ]| [Cancel] 0

FIGURE 4-22 SDI Setup dialog box

2. Your MacSPIRS administrator entered default settings when
authorizing SDIs. Change these settings only if you have been told
to do so.

At WebSPIRS Address enter the URL for the version of
WebSPIRS you are using to access SDIs.

* At UserID and Password enter the user id and password you
have been told to use for accessing SDIs.

3. Click OK to save your changes.

Subscribing to an Your MacSPIRS administrator may have set up some Alerts. These are
Alert pre-configured searches, similar to SDIs, that you can subscribe to, and
have the search results emailed to you automatically by the system.
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To subscribe to an alert:

1. Choose Alert Service. from the File menu. This opens a browser,
and connects to WebSPIRS.

2. Inthe WebSPIRS Alerts screen, choose any Alerts you want to
subscribe to, and enter your email address.

See the WebSPIRS online help for more information about subscrib-
ing to Alerts.

Searching Multiple Databases

With MacSPIRS, you can search more than one database at a time.
When doing so, you must keep the following in mind:

*  The databases may not have all fields in common; if you search in a
specific field (either in the Find Records dialog box or in the Index),
you can only retrieve records from those databases that contain the
field.

*  The Thesaurus is unavailable, even if each of the selected databases
has a Thesaurus.

»  The Suggestions feature is unavailable.
»  Each database has its own set of Guides in the Help menu.

Refer to “Selecting a Database” on page 3—2 for instructions on selecting
multiple databases.

Narrowing and Broadening Your Search

If your initial search request retrieves too many or too few records, you
can narrow or broaden the search using the following techniques. These
are discussed further in other sections of this chapter.

To narrow your search:

»  Search in a specific field (see page 4-9)
*  Search in a limit field (see page 4—10)

»  Combine your search with additional terms using the and, near, not,
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adj, and with operators (see page 4—6)

Select more specific terms from the Index or Thesaurus (see page 4—
12 and page 4-15)

To broaden your search:

Use truncation and wildcards to retrieve variations of your search
terms (see page 4—4)

Combine your search with additional terms using the or operator
(see page 4-6)

Select broader terms from the Index or Thesaurus (see page 4—12
and page 4-15)

Search multiple databases (see page 4-29)
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Showing Records

Changing Show
Options
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Using Retrieved Records

Once you have searched for and retrieved records of interest, you have
several options, including displaying, printing, and saving records, and
marking a subset of records. You can also output records in a variety of
formats by changing the Show, Print, and Save options.

MacSPIRS displays records automatically after each search if you have
the Inmediate Record Display option turned on in the Options for Show
dialog box. For faster searching, you can turn this option off, and then
show records in one of the following ways:

*  Use the up and down arrows to highlight the search you want, and
click Show Records Found in the Find Records dialog box.

*  Double-click on any search in the Search History; MacSPIRS
highlights the search and displays the records in the Retrieved
Records dialog box.

The Options for Show dialog box allows you to select fields and field
labels, and control the immediate record display feature.

1. Select Options for Show from the Show menu. MacSPIRS displays
the Options for Show dialog box.
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Options for Show —"——=H

Select Fields

[ Remember Field Selections

[] DB Qualify Fields

Field labels: (O Llong @& Short ) None

Immediate Record Display

OO (me) @

FIGURE 5-1 The Options for Show dialog box

If necessary, click Select Fields to select the fields you want to
show. See “Showing a Subset of Fields” on page 5—4 for instructions
on selecting fields.

Your selections will remain in effect until you reset them, or until
you quit or restart MacSPIRS, unless you check the Remember
Field Selections option.

Check Remember Field Selections if you want MacSPIRS to re-
member the field settings you have selected, and show only those
fields for all records you retrieve from any database. (See “Showing
a Subset of Fields” on page 5—4 for instructions on selecting fields.)

If you want MacSPIRS to use your field selections for only the da-
tabase you are using now, and any member of that database family,
check both Remember Field Selections and DB Qualify Fields.

This information is stored with your preferences. Next time you start
MacSPIRS, or exchange databases, you see a message saying that
your preferences override the entry in your configuration file (your
.ini file). If you only checked Remember Field Selections Mac-
SPIRS shows records with the fields you have selected. If you
checked both options, MacSPIRS displays records with all fields,
except for the database family that was current when you checked
the DB Qualify Fields option. For that database family, MacSPIRS
uses only your selected fields.

Select the Field Labels option you want:

*  Click Long to display records with full field names, such as
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“Title.”

*  Click Short to display records with abbreviated field names,
such as “TI” for the “Title” ficld. MacSPIRS displays retrieved
records with short field labels by default.

*  Click None to display records without field names.

5. Uncheck Immediate Record Display to prevent MacSPIRS from
displaying records automatically after each search.

Note: You can also disable the immediate record display default
through the macspirs.ini file. For more information, see “Configur-
ing MacSPIRS” on page 2—12.

6. Click OK.
Showing a Subset of If your search yields a large number of records, you can show a more
Records precise subset of records.

1. Click Show Subset in the Show Records dialog box. MacSPIRS
displays the Show Subset dialog box.

Show Subset

@ Selected Records

() Current Search

Skip to Record # I:l
&

FIGURE 5-2 The Show Subset dialog box

2. Select one of the subset options:

*  Click Selected Records to show only selected records. (This
option is disabled if you haven’t selected any records. Refer to
“Selecting Records” on page 5-9 for more information.)

e Click Current Search to show all records retrieved from the
currently highlighted search in the Search History window.

3. Ifyou want to skip to a particular record within the subset, type the
number of the record in the Skip to Record # box. This number must
not be greater than the number of records found and, if you have
chosen to display a subset of selected records, the number specified
must correspond to one of the selected records.
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Showing a Subset of
Fields

The Select Fields dialog box allows you to choose the fields you want to
include when displaying records. You can select and show all fields, or a
particular subset of fields.

To show a subset of fields:

1. Click Select Fields in either the Show Records or Options for Show
dialog box. MacSPIRS displays the Select Fields dialog box which
lists all of the fields and fieldsets available for selection.

Click on short names to select fields

- Linivarssl Flalds
&Ll ALL FIELDS
HITS HITS
v CITM CITATION [TI,AU,50,PT,PY,AN,CA
v TI TITLE
v AU AUTHOR
v S0 SOURCE
v PT  PUBLICATION TYPE
v PY  PUBLICATION YEAR

NT  NOTES
La LANGUAGE
&8 ABSTRACT

l 0K l Clear Cancel @

FIGURE 5-3 The Show Records-Select Fields dialog box

2. Ifyou want to see a description and search example for a field, click
on its long name.

3. Click on the short name of each field you want to show. MacSPIRS
places a check to the left of your selections. Note that if you select a
fieldset, MacSPIRS places a check to the left of all of the fields that
make up the set.

» Todisplay all fields, select ALL Fields.

*  To display most fields, select ALL Fields and then deselect
those fields that you do not want to display.

* To display only fields that contain one of your search terms,
select Hits. “Hits” are occurrences of your search terms in
retrieved records. Since hits occur in different fields from one
record to the next, selecting Hits is the most efficient way of
displaying all occurrences of your search terms.

4. If you want to deselect a field, click again on its short name.
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MacSPIRS removes the check.

To clear all field selections at once, click Clear. However, you must
make at least one field selection before clicking OK.

5. Click OK when you have selected the fields you want to display.

MacSPIRS lets you sort retrieved records by a specific field. You can
sort the fields in ascending or descending order.

To sort records:

1. Select Sort Records from the Show menu, and choose one of the
submenu options:

*  Select Records from Search to sort records from the current
search. (This option is available only if your search retrieves
1,000 records or fewer.)

*  Select Selected Records to sort selected records. (This option
is disabled if you haven’t selected any records. Refer to
“Selecting Records” on page 5-9 for more information.)

MacSPIRS displays the Sort Records dialog box.

Select field to sort on

TITLE

ORIGINAL TITLE
COMMENTS
AUTHOR(S)

ADDRESS OF AUTHOR
SOURCE (BIBLIOGRAPHIC CITATION
Library Haldings Messaqge

) Not Sorted
i Ascending

3 Descending

Cx ) (o) €@

FIGURE 5-4 The Sort Records dialog box

2. Select the field you want to use to sort the records.
3. Select one of the sorting options:

*  Click Not Sorted to undo the last sort and display records in
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their original order.
*  Click Ascending to sort in ascending order (1-100; A-Z).
*  Click Descending to sort in descending order (100-1; Z-A).

4. Click OK. MacSPIRS displays the sorted records in the Retrieved
Records window.

Searching from Retrieved Records

You may see a word or phrase in a retrieved record that suggests an
alternative search strategy. You can select the terms for searching and
MacSPIRS automatically places them in the Find Records dialog box.
This process is often referred to as “lateral searching.”

To conduct a lateral search:

1. Browse through the retrieved records using the scroll bar and the
Next Record and Previous Record buttons.

2. When you identify a term in one of the records that suggests another
search, hold down the Option key and click on or drag across the
term. MacSPIRS places that term in the Find Records dialog box,
followed by the short name of the field from which the text was
selected.

If a term already exists in the dialog box, MacSPIRS adds the or op-
erator before adding the new term.

3. Click Start Search.

Displaying Hotlinked Records

In some SilverPlatter databases, records may be linked to other relevant
records. These links, called kotlinks, appear as underlined text within
records. If you retrieve a record that contains hotlinks, you can show,
print, and save the linked records.

The database Guide in the Help menu may tell you if the database you
are searching has hotlinks.

To show a hotlinked record:
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Click on the hotlink text. MacSPIRS displays the linked record in
the Retrieved Records window.

If there are links within this record, you can click on the hotlink text
to see them.

Click Back(#) in the Show Records dialog box to move backward
through the linked records you have viewed. Alternatively, click
Back to Origin (available after two or more links) to return
immediately to the original record.

Show Records

[ mgd Hoonyd ] [ Select Fields ] [ Selected Records ]
[?ﬁ?z;émzx §§<e<z>z’z§] [ Back to Origin ] [ Back (2) ] @

FIGURE 5-5 The Show Records dialog box (for hotlinked records)

To print a hotlinked record:

1.
2.

3.
4.

Show a hotlink record as described above.

Select Print Records from the File menu or hold down the
Command key and press [P]. MacSPIRS displays the Print Records
dialog box. The Hotlink option is automatically selected.

Change the other print settings if necessary.
Click Print.

Refer to “Printing Records” on page 5—12 for more information.

To save a hotlinked record:

1.
2.

5.

Show a hotlink record as described above.

Select Save Records from the File menu. MacSPIRS displays the
Save Records dialog box. The Hotlink option is automatically
selected.

Change the other dialog settings if necessary.

Click Save.... MacSPIRS displays the Macintosh File Save dialog
box.

Specify a file name and destination, then click Save.

See “Saving Records” on page 5—15 for additional information.
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SilverLinker Support

If your organization has set up support for the SilverLinker database, you
will see a new field, called FTXT (meaning full text), in some of the
displayed records.

This field contains direct links to full text articles, located at publisher
web sites. If you click on the link, your default web browser launches
automatically, and links to the site containing the article.

If you know that you have SilverLinker support but you do not see any
records with full text links, check that you have set your options for
displaying records to include the field FTXT. (See “Changing Show
Options” on page 5—1.) If you still do not see any full text links, ask your
MacSPIRS administrator which publisher sites you have access to: your
search may not be finding any records for articles at those sites.

O Retrieved Records B
Display of Selected Records sl
1o0f 2 —
TI: Cats are protected against feline immunodeficiency wirus infection following vaccination with a homologous AP-1
bindi ng site-deleted mutant.
AU: Kohmoto-M; Miyazawa-T; Sato-E; Uetsuka-K; Nishimura-Y; [keda-Y; Inada-G; Doi-K; Mikami-T
S0: Arch-¥irol. 1995; 143{9): 1839-45
FTXT: Full text from Springer-Verlag Link {US Mirror) Full text from Springet -Verlag Link Full text from Swetsblat
Full text from Swetshet
FLHM: AGG 47- 1975 Y26 47- 1975 Y26 YZBS 47- 1975
2of 2
TI: Evaluation of a commercial ELISA test for the detection of allergen-specific 1gE antibodies in atopic dogs,
AU: Ginel-PJ; Riano-C; Lucena-R
S0: Zentralbl -Veterinarmed-B. 1995 Sep; 45(7): 421-5
FLHM: NBT 7- 1970 MGK Current four year
MNGM 9- 1973 5EE 1990 5EJ LATEST T'wWO YEAR
SEK Current year
S5FI Current ten year
SG0 Microfilm 20- 1983- .Current year hardoopy
Wi Retains current eleven years
also see : Online library
-|
[ [+

FIGURE 5-6 Record displaying a SilverLinker link and library holdings
information

Displaying Local Library Holdings Information

When you look at records retrieved by a search, you may also see details
of local library holdings: that is, information about whether your library
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has a copy of the publication, and if so, where it is stored. The exact
details you see depend on whether your MacSPIRS administrator has set
this feature, and the amount of detail about location and availability that
they have decided to include.

You can only see holdings information if the fields *LHM and *LHC are
supported by the database, and if you select them to display. See
“Changing Show Options” on page 5—1.

FIGURE 5-6 shows records with the field *LHM. One record shows the
library reference number for the article. The second record has a hotlink
to an electronic copy of the publication.

You can select a subset of the records retrieved by your most recent
search request and then show, print, or save the subset, rather than the
entire set of retrieved records.

1. Ifnecessary, perform a search and click Show Records Found to
display the Retrieved Records window.

2. Inthe Retrieved Records window, browse the records using the
scroll bar or Next Record and Previous Record buttons.

3. Select any record of interest by clicking on its record number, such
as 2 of 492. The number appears in bold to indicate that the record is
selected.

4. Continue browsing and select all relevant records.
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Retrieved Records

Display of Search *5 : *3and {proteinin ti}

1of 492 - MEDLINE (R} 1/95-4/95
TI: Tissue distribution of the receptor for plasma retinol-binding
protein,

AlU: Smeland-5; Bjerknes-T; Malaba-L; Eskild-'w; Norum-KR;
Bold indicates | Blomhaff-R
AD: Institute for Nutrition Reszearch, School of Medicine, University
selected of 0slo, Norway.
50: Biochem-J. 1995 Jan 15; 305 ( Pt 2): 419-24
I r ;
ecords LA: EMGLISH

AN: 95134220
= 2 of 492 - MEDLINE (R} 1/95-4/95

TI: Effect of 5-HT agonists on rats fed single diets with warying
proportions of carbohydrate and protein.

AU: Luo-5; Li-ET

80: Psychopharmacology-Berl, 1992; 109{1-2): 212-%

LA: EMNGLISH

AB: Low doses of 5-HT agonists have been shown to selectively
suppress carbohydrate intake in rats given dietary choices. To
investigate further the relationship between dietary macronutrient

o
<o D)

FIGURE 5-7 A selected record

Using the Show 1. Click Selected Records in the Show Records dialog box.
Records dialog box MacSPIRS displays the Selecting Records dialog box.

Selecting Records

Select records by clicking on the record number
(e.g. 1 of 10). Selected records have record
numbers in bold type. Click again to deselect the
record. It is not necessary to open this dialog
before selecting a record.

Alternatively, type the numbers you want to
select here. Note that a marimum of 250 records
can be selected at one time.

2,3,5-6 |

[I:Iear All Selected Hecurds]

D = @

FIGURE 5-8 The Selecting Records dialog box

2. Enter the records you want to select. You can enter a single record
number, a non-consecutive group of numbers, or a range.

3. Click OK to select the records.
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Do one of the following:

*  Click again on any selected (bold) record number in the Retrieved
Records dialog box.

*  Click Clear All Selected Records in the Selecting Records dialog
box.

Note: If you attempt to exchange databases or restart or quit MacSPIRS
with one or more selected records, MacSPIRS displays the Selected
Records Warning dialog box, which allows you to print, save, or discard
the selected records.

Selected Records Warning

You have selected records which you may
not have printed or saved. These will be lost
if you Restart, Exchange or Quit.

[ Print selected records ]

(< Then discard

[ Save selected records ]

[[ Discard Selections ]] 0

FIGURE 5-9 Selected Records Warning dialog box

You must discard all selected records before exchanging, restarting, or
quitting.

*  Click Print selected records or Save selected records to print or
save the records.

If Then discard is checked, MacSPIRS discards the selected records
after printing or saving them, and continues with the exchange, re-
start, or quit.

If Then discard is unchecked, MacSPIRS re-displays the Selected
Records Warning after printing or saving the records.

*  Click Discard Selections to discard the selected records and
continue with the exchange, restart, or quit.

Refer to “Printing Records” on page 5—12 and “Saving Records” on page
5—15 for more information.
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Printing Records

With MacSPIRS, you can print the records retrieved by the current
search. You can also determine which records and fields are printed, and
whether the search history is included.

To print records:

Select Print Records from the File menu or hold down the
Command key [ # ] and press [P]. MacSPIRS displays the Print
Records dialog box.

=—— Print Records =———"—
Select Fields | 5elected fields will be printed

@ Selected Records (O All Records ) Hotlink

[ Include Search History

Separate Pages @ No i Yes
Start printing from record# IE'
o

FIGURE 5-10 The Print Records dialog box

If necessary, click Select Fields to select the fields you want to
print. Refer to “Printing a Subset of Fields” on page 513 for
instructions on selecting fields.

Select the records you want to print:

*  Click Selected Records to print only the records you have
selected.

»  Click All Records to print all retrieved records.

*  Click Hotlink to print only hotlinked records. (See “Displaying
Hotlinked Records” on page 5—6 for more information on
hotlinks.)

If you want to print the contents of the Search History window along
with your printed records, click the Include Search History box.

Select a separate pages option:
*  Click No to print without page breaks after each record.
*  Click Yes to print each record on a new page.

Use the Start printing from record # box to set a record number at
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which you want your print run to begin. The default is the first
retrieved record, or the first record of the selection.

7. Click Print. MacSPIRS displays a progress message. To stop
printing, click the Break button displayed with the message.

The fields to be printed are indicated by the message next to the Select
Fields button in the Print Records dialog box. By default, all fields are
printed. However, you can use Select Fields to choose the fields you
want to print.

To print a subset of fields:

1. Click Select Fields in the Print Records dialog box. MacSPIRS
displays the Select Fields dialog box which lists all fields and
fieldsets available for printing.

Click on short names to select fields

- Linfvarssl Fielos
ALL  ALL FIELDS
HITS HITS
« CITH CITATIOM [TI,AU,50,PT PY,AN,CA,
v TI TITLE
v Al AUTHOR
« S0 SOURCE
v PT  PUBLICATION TYPE
v PY PUBLICATION YEAR

MT  MNOTES
L& LANGUAGE
&b ABSTRACT

l 0K I Clear Cancel @

FIGURE 5-11 The Print Records-Select Fields dialog box

2. Ifyou want to see a description and search example for a field, click
on its long name.

3. Click on the short name of each field you want to print. MacSPIRS
places a check to the left of your selections. Note that if you select a
fieldset, MacSPIRS places a check to the left of all of the fields that
make up the set.

»  To print all fields, select ALL Fields.

*  To print most fields, select ALL Fields and then deselect those
fields that you do not want to print.
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Changing Print
Options

*  To print only the fields that contain one of your search terms,
select Hits. “Hits” are occurrences of your search terms in
retrieved records. Hits occur in different fields from one record
to the next, so selecting Hits is the most efficient way of printing
all occurrences of your search terms.

4. Ifyou want to deselect a field, click again on its short name.
MacSPIRS removes the check.

To clear all field selections at once, click Clear. However, you must
make at least one field selection before clicking OK.

5. Click OK when you have selected the fields you want to print.

The Options for Print dialog box allows you to control how the records
retrieved by your most recent search are printed. You can indicate
whether you want hits highlighted and how you want field labels
printed.

1. Select Options for Print from the File menu. MacSPIRS displays
the Options for Print dialog box.

Options for Print ——"———8

[ Highlight Hits
Field Labels (3 Llong @& Short (3 None

[ Remember Field Selections

[] DB Qualify Fields

m Cancel I @

FIGURE 5-12 The Options for Print dialog box

2. Check the Highlight Hits box to highlight your search terms where
they appear in the retrieved records. Hits are highlighted by default.

3. Select the Field Labels option you want:

*  Click Long to print records with full field names, such as
“Title.”

*  Click Short to print records with abbreviated field names, such
as “TI” for the “Title” field. MacSPIRS prints retrieved records
with short field labels by default.

*  Click None to print records without field names.
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Check Remember Field Selections if you want MacSPIRS to

remember the field settings you have selected, and print only those
fields for all records you retrieve from any database. (See “Showing
a Subset of Fields” on page 5—4 for instructions on selecting fields.)

If you want MacSPIRS to use your field selections for only the da-
tabase you are using now, and any member of that database family,
check both Remember Field Selections and DB Qualify Fields.

This information is stored with your preferences. Next time you start
MacSPIRS, or exchange databases, you see a message saying that
your preferences override the entry in your configuration file (your
.ini file). If you only checked Remember Field Selections Mac-
SPIRS prints records with the fields you have selected. If you
checked both options, MacSPIRS prints records with all fields, ex-
cept for the database family that was current when you checked the
DB Qualify Fields option. For that database family, MacSPIRS
prints only your selected fields.

Click OK.

With MacSPIRS, you can save the records retrieved by the current
search.You can also determine which records and fields are saved, and
whether the search history is included.

To save records:

1.

Select Save Records from the File menu. MacSPIRS displays the
Save Records dialog box.

Save Records

select Fields | Selected fields will be saved

@ Selected Records ANl Records ) Hotlink

[ Include Search History

§tart saving from record# IE'
[Saue ] [ Cancel ] 0

FIGURE 5-13 The Save Records dialog box

If necessary, click Select Fields to select the fields you want to
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Saving a Subset of
Fields

include in the saved records. Refer to “Saving a Subset of Fields” on
page 516 for instructions.

Select the records you want to save:

*  Click Selected Records to save only the records you have
selected.

*  Click All Records to save all records retrieved from your most
recent search.

*  Click Hotlink to save only hotlink records. For more
information on hotlinks, refer to “Displaying Hotlinked
Records” on page 5-6.

If you want to save the contents of the Search History window along
with your saved records, click the Include Search History box.

Use the Start saving from record # box if you want to start saving
with a specific record number. The default is the first retrieved
record, or the first record of the selection.

Click Save.... MacSPIRS displays the Macintosh Save dialog box,
which allows you to specify a name and destination for your saved
file.

Type the name of the file and specify a drive and folder in which to
save the retrieved records.

Click Save. MacSPIRS displays a progress message. To stop
saving, click the Break button displayed with the progress message.

The fields to be saved are indicated by the message next to the Select
Fields button in the Save Records dialog box. By default, all fields are
saved. However, you can use Select Fields to choose the fields you want
to save.

To save a subset of fields:

Click Select Fields. MacSPIRS displays the Select Fields dialog
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box which lists all fields and fieldsets available for saving.

Click on short names to select fields

- Linfvarsal Frsios
ALL  ALL FIELDS
HITS HITS
« CITH CITATIOM [T1,AU,50,PT,PY, AN,CA,
v TI TITLE
v Al AUTHOR
v S0 SOURCE
« FT  PUBLICATION TYPE
v PY PUBLICATION YEAR

WT  MNOTES
L& LANMGUAGE
AB ABSTRACT

| 0K I Clear Cancel @

FIGURE 5-14 The Save Records-Select Fields dialog box

To see a description and search example for a field, click on its long
name.

Click on the short name of each field you want to save. MacSPIRS
places a check to the left of your selections. Note that if you select a
fieldset, MacSPIRS places a check to the left of all of the fields that
make up the set.

* To save all fields, select ALL Fields.

* To save most ficlds, select ALL Fields and then deselect those
fields that you do not want to save.

* To save only the fields that contain one of your search terms,
select Hits. “Hits” are occurrences of your search terms in
retrieved records. Since hits occur in different fields from one
record to the next, selecting Hits is the most efficient way of
saving all occurrences of your search terms.

If you want to deselect a field, click again on its short name.
MacSPIRS removes the check.

To clear all field selections at once, click Clear. However, you must
make at least one field selection before clicking OK; you cannot save
records if no fields have been selected.

Click OK when you have selected the fields you want to save.
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Changing Save
Options

The Options for Save dialog box allows you to control how the records
retrieved by your most recent search are saved. You can indicate how
you want field names saved and, if a file with the name you intend to use
exists, whether you want to replace it or append to it.

1. Select Options for Save from the File menu. MacSPIRS displays
the Options for Save dialog box.

Options for Save ———H

Field Labels ) Long @@ Short () None

Iffile exists: () Replace @& Append

[ Remember Field Selections

[] DB Qualify Fields

H 0K ]| [ Cancel ] 0

FIGURE 5-15 The Options for Save dialog box

2. Select the Field Labels option you want:

Click Long to save records with full field names, such as
“Title.”

Click Short to save records with abbreviated field names, such
as “TI” for the “Title” field. MacSPIRS saves retrieved records
with short field labels by default.

Click None to save records without field names.

3. Select the If file exists option you want:

Click Replace to overwrite the contents of an existing file with
the same name. This means that you will no longer be able to
access the data originally held in that file. As an alternative, you
can either append the saved records to the existing file, or
specify another (unused) file name.

Click Append to add the saved records to the contents of an
existing file. MacSPIRS appends saved records to the specified
file by default.

Check Remember Field Selections if you want MacSPIRS to

remember the field settings you have selected, and save only those
fields for all records you retrieve from any database. (See “Showing
a Subset of Fields” on page 5—4 for instructions on selecting fields.)
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If you want MacSPIRS to use your field selections for only the da-
tabase you are using now, and any member of that database family,
check both Remember Field Selections and DB Qualify Fields.

This information is stored with your preferences. Next time you start
MacSPIRS, or exchange databases, you see a message saying that
your preferences override the entry in your configuration file (your
.ini file). If you only checked Remember Field Selections Mac-
SPIRS saves records with the fields you have selected. If you
checked both options, MacSPIRS saves records with all fields, ex-
cept for the database family that was current when you checked the
DB Qualify Fields option. For that database family, MacSPIRS
saves only your selected fields.

Click OK.
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MacSPIRS Commands

Chapter 6
This chapter briefly describes all of the MacSPIRS menu commands. For
more information, refer to the Index or the online Help

Menu Option Menu Does this

Browse Index Search Lets you look up a term in any available index in the current da-
tabase and to browse for related terms, more specific terms, and
spelling variations. You can then select and search for terms
knowing exactly how many records you will retrieve.

Browse Thesaurus Thesaurus If the database you are searching includes a thesaurus, this lets
you look up, get details about, and search for, thesaurus terms.

Clear Edit Erases selected text from the Find Records, Browse Index, or
Browse Thesaurus dialog box.

Clear Searches Search Lets you remove search requests from the Search History win-
dow.

Copy Edit Copies the highlighted text to the Clipboard for later pasting.

Cut Edit Removes selected text and places a copy of it in the Clipboard.

Exchange Databases File Lets you switch databases without leaving MacSPIRS.
Note: This command is unavailable if the Allow users to ex-
change databases option is disabled during MacSPIRS installa-
tion.

Find Records Search Lets you create a new search request or to view a list of your pre-
vious searches (the search history.)

Font Show Lets you select the font you want to use for displaying and print-

ing retrieved records.
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Menu Option

Menu

Does this

Guide to...

Help on SilverPlatter
Help

Hide Clipboard

Hide Intermediate Re-
sults

Lateral Search

List Databases and
Fields

MacSPIRS Help

Next Hit

Next Record

Help

Help

Edit

Search

Search

Help

Help

Show

Show

Provides specific help on all currently loaded databases, and in-
cludes the following commands

Guide Topics provides a list of Help topics for the selected data-
base. Common topics include an Introduction, Examples, and
Stopwords.

Guide Fields lists the fields contained in the selected database.
You can get a description and search example for any field by
clicking on it.

Guide Keywords is an index of all the key words and phrases
used in the Guide Topics.

Provides instructions on using the Help menu and context-sensi-
tive help.

Closes the Macintosh Clipboard (the facility that holds the last
item of information that you stored using Cut or Copy.) Once you
close the Clipboard, the command name changes to Show Clip-
board.

Prevents MacSPIRS from displaying search results for each
word in your search phrase in the Search History window.

When you select Hide Intermediate Results, the menu item
changes to Show Intermediate Results.

If a retrieved record contains a word or phrase that you would like
to add to your search, use this command to add the term auto-
matically to the Find Records dialog box.

Displays a list of all databases and fields currently in use.

Provides help on using the MacSPIRS software. It includes the
following commands:

MacSPIRS Help Topics offers general advice on using Mac-
SPIRS. Topics include searching, using the Index and Thesau-
rus, and printing, saving, and showing records.

MacSPIRS Help Keywords is an index of all the key words and
phrases used in the MacSPIRS Help Topics.

Moves to the next occurrence of your search term within the re-
trieved records.

Moves to the record immediately following the current record.
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Options for Print File Lets you control how the records retrieved by your most recent
search are printed. You can indicate whether you want hits high-
lighted, how you want field names printed, and which fields you
want to print.

Options for Save File Lets you control how the records retrieved by your most recent
search are saved. You can indicate how you want field names
saved, which fields you want to save, and, if a file with the name
you intend to use exists, whether you want to replace it or append
toit.

Options for Show Show Lets you select fields and field labels (and save those settings),
and control the immediate record display feature.

Page Setup File Lets you change the format, orientation, etc., of the page on
which your retrieved records will be printed. See your Macintosh
documentation for more information on Page Setup options.

Paste Edit Inserts the contents of the Clipboard at the current insertion point.
You can paste text into the Find Records, Browse Index, or
Browse Thesaurus text entry box, or into another application.

Preferences Edit Lets you set certain interface preferences, including the color of
various display elements, font and font size, and window posi-
tions.

Previous Hit Show Moves to the previous occurrences of your search term within the
retrieved records.

Previous Record Show Moves to the record immediately preceding the current record.

Previous Topic Help Returns to the Help topic from which you linked.

Print Records File Prints the records retrieved by your most recent search request.

Quit File Clears the Search History window, resets all options and window
sizes to their defaults, and returns to the Macintosh Desktop.

Restart Session File Clears the Search History window, resets all options and window
sizes to their defaults, and returns to the database selection
screen.

Run Search History  File Runs the search requests you saved during past work sessions.

Save Records File Use to transfer the records retrieved by your most recent search

to a disk or hard disk.
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Menu Option

Menu

Does this

Save Search History

SDIs

Select Index
Show All Records
Show Clipboard

Show Intermediate
Results

Show Selected
Records

Show Selected Term

Show Selected Tree

File

File
(if enabled)

Search
Show
Edit

Search

Show

Thesaurus

Thesaurus

Use to save any search requests you want to run during future
work sessions.

Save as SDI lets you set up an SDI. After conducting a search
and choosing this menu item, MacSPIRS 4 links automatically to
WebSPIRS and displays the Create SDI screen.

Show SDI Account lets you edit or administer existing SDIs by
linking to WebSPIRS to view an account you set up previously

Alerts lets you view and subscribe to alerts (searches set up by
a librarian or administrator) by linking to WebSPIRS.

SDI Set up lets you view and edit your SDI settings.
Use to change to the index of another field or set of fields.
Displays the records retrieved by your most recent search.

Opens the Macintosh Clipboard (the facility that holds the last
item of information that you stored using the Cut or Copy com-
mand.)

When the Clipboard is open, the command name changes to
Hide Clipboard.

Displays search results for each word in your search phrase in
the Search History window.

When you select Show Intermediate Results, the menu item
changes to Hide Intermediate Results.

Displays the records you select from the Retrieved Records win-
dow or through the Selecting Records dialog box.

Displays the Selected Term Details window, which indicates
broader, narrower, and related terms for the selected thesaurus
term, and the Selected Term dialog box, which allows you to
search for the selected term.

If the database does not include a thesaurus or you have not se-
lected a thesaurus term, Show Selected Term is not available.

If the database you are searching includes a thesaurus with a hi-
erarchical, or “tree,” structure, Show Selected Tree displays the
most recently selected tree in the Trees—Hierarchical Display of
Terms window.

If the database does not have a thesaurus or you have not select-
ed a thesaurus tree, Show Selected Tree is not available.



Menu Option

Menu

Does this

Sort Records

Show

Lets you sort retrieved records by a specific field. You can sort
the records in ascending (1-100; A-Z) or descending (100-1; Z-A)
order.




6-6 MacSPIRS Commands



A
ADJ operator 4-7
Alerts
configuring 2-18
subscribing to 4-28
All Records option
for printing 5-12
for saving 5-16
AND operator 4-6, 4-29
anti-virus programs 2-2
Append option, for saving 5-18
AppleTalk network 2-12
application types
Both (Client & standalone) 2-6
ERL Client Only 2-6
Standalone Only 2-6
authors. see hyphenated phrases;
searching in specific fields
automatic login to ERL 2-9
Automatic Restart option 2-9
Automatic Subject Lookup. see suggested
terms
automatic subject lookup. see suggested
terms

B
Boolean operators. see operators
Both (Client & standalone) applications 2-
6
Break button
for printing 5-13
for saving 5-16
for searching 4-6
broader terms. see Thesaurus
Browse Index 4-13, 6-1
see also Index
Browse Thesaurus 4-15, 6-1
see also Thesaurus

Index

C
cancelling. see Break button
Change Index 4-14, 6-4
see also Index
changing
colours 2-16
databases 2-8, 3-4, 4-29, 6-1
font size 2-16
fonts 2-16, 6-1
indexes 4-14, 6-4
options
for printing 5-14, 6-3
for saving 5-18
for showing 5-1, 6-3
see also options
Clear Searches 4-23, 6-1
clearing text 6-1
Clipboard
hiding 6-2
showing 6-4
combining search terms 4-4, 4-6, 4-8
configuring MacSPIRS
default fields 2-13
file names 2-14
Immediate Record Display 2-12
memory requirements 2-14
subdirectory access 2-13
contents. see Table of Contents
context sensitive Help 3-10
contracting topics
see also Table of Contents
conventions. see Manual conventions
copying text 6-1
current awareness searches
configuring SDIs and Alerts 2-17
using SDIs and Alerts 4-26
Current Search option, for showing 5-3
cutting text 6-1



D
databases
database-specific help 3-10-3-13, 6-
2

exchanging 2-8, 3-4, 4-29, 6-1
full-text. see Table of Contents
listing 3-11, 3-12, 6-2
selecting 3-2
selection screen 3-3
title screen 3-2, 3-3
see also searching
dedicated workstation, creating 2-15
deleting
see also clearing
descriptors. see hyphenated phrases;
Thesaurus
displaying. see showing
displaying. see showing
downloading MacSPIRS 2-2

E
Eject button 3-4
Electronic Reference Library (ERL)
erlcint.cfg file 2-7
installing ERL clients 2-3-2-10
login information
concealing 2-10
passwords 2-9
server IDs 2-9
usernames 2-9
server addresses 2-7
ERL. see Electronic Reference Library
(ERL)
examples of searching 4-3
exchanging databases 3-4, 4-29, 6-1
installation option 2-8
exiting MacSPIRS 3-13
expanding topics
see also Table of Contents
Explode Term 4-15
extracting MacSPIRS files 2-3

F
fields
field-specific indexes. see Index
limit fields 4-11, 4-29
listing 3-11, 3-12, 6-2
names (labels)
in search requests 4-11
printing 5-13
saving 5-16
searching in 3-12, 4-4, 4-9
showing 5-4, 5-14, 5-17
with hits 5-4, 5-14, 5-17
file server 2-11
finding records 3-3, 3-6, 4-2, 6-1
see also searching
finding records. see searching
fonts 2-16, 6-1
FTPing SilverPlatter software 2-2
full text. see Table of Contents

G
Guide to database 3-11, 6-2

H
Help
database-specific guide 3-10—3-13,
6-2
MacSPIRS Help 3-10-3-13, 6-2
history. see search history; Thesaurus
history
hits, showing 5-4, 5-14, 5-17
Hotlinks
definition of 5-6
printing 5-7, 5-12
saving 5-7, 5-16
showing 5-6
hyphenated phrases 4-4
|
Immediate Record Display 2-12, 5-3
IN operator 4-4, 4-9, 4-10
Include Search History



with printed records 5-12

with saved records 5-16
Index

authors in 4-5

broadening searches with 4-30

changing 4-14, 6-4

descriptors in 4-5

hyphenated phrases in 4-5

narrowing searches with 4-30

overview 3-8

searching 4-12

selecting terms from 4-13
installing MacSPIRS 2-1-2-12

application types 2-6

code types 2-6

installation types 2-4

network instructions 2-11

software options 2-8—2-9
interface preferences

Colours 2-16

defaults 2-16

Font 2-16, 6-1

Font Size 2-16

Preferences command 6-3

Save window settings 2-16
intermediate search results

hiding 6-2

showing 4-2, 6-4

L

lateral searching 5-6

library holdings
displaying details 5-8

limit fields 4-10, 4-11, 4-29

List Databases and Fields 3-11, 3-12, 6-
2

List of Available Indexes 4-13, 4-14

List of Permuted Terms 4-16

M
MacSPIRS
configuring 2-12-2-15

jii

Help 3-10-3-13, 6-2
installing 2-1-2-12
interface preferences 6-3
License Agreement 2-5
Overrides folder 2-11
quitting 3-13, 6-3
restarting 3-13, 6-3
starting 3-1

Manual conventions Vii

memory requirements 2-14

menu Help 3-10, 6-2

N

narrower terms. see Thesaurus

narrowing search requests 4-29

natural language mapping. see suggested
terms

NEAR operator 4-6, 4-29

Next Record 5-6, 5-9, 6-2

NOT operator 4-8, 4-29

Novell server 2-11

0]
operators
ADJ 4-7
AND 4-6, 4-29
definitions of 4-6
IN 4-4, 4-9, 4-10
in limit fields 4-11
NEAR 4-6, 4-29
NOT 4-8, 4-29
OR 4-7, 4-14, 4-30, 5-6
WITH 4-6, 4-29
Options for Print 5-14, 6-3
Options for Save 5-18
Options for Show 5-1, 5-2, 6-3
options. see installing MacSPIRS;
printing; saving; showing
OR operator 4-7, 4-14, 4-30, 5-6

P
Page Setup, print option 6-3



parentheses 4-4
parentheses in search requests 4-5
passwords, ERL 2-9
pasting text 6-3
Permuted Terms 4-16
Preconfigure Defaults 2-4
Preferences. see interface preferences
preferences. see options
preferred terms 4-15
Previous Hit 6-3
Previous Record 5-6, 5-9, 6-3
Previous Topic 6-3
printing

Break button 5-13

fields, selected 5-13

hotlink records 5-7

options 5-14

Page Setup 6-3

Printable Records option 2-8

records 5-12-5-15

search histories 4-22, 5-12
proximity operators. see operators

Q
quitting MacSPIRS 3-13, 6-3
quotes 4-4

R
range searching 4-11
Reconfigure Installed Application 2-4
records
deselecting 5-11
printing 5-12—5-15
saving 5-15-5-19, 6-3
scrolling 5-6
selecting
for printing 5-9-5-10
for saving 5-9—-5-10
for showing 5-9-5-10
terms from 5-6
showing 5-1-5-5, 6-4
sorting 5-5, 6-5

see also downloading; printing;
searching; showing
related terms 4-15
related terms. see Thesaurus
Replace option, for saving 5-18
restarting MacSPIRS 3-13, 6-3
installation option 2-9
reusing search requests 3-4, 4-4, 4-22
Run Search History 4-24, 4-25, 6-3

S
Save Records 5-15, 6-3
Save Search History 4-23, 6-4
saving
Break button 5-16
fields, selected 5-16, 5-17
options 5-18
records 5-15-5-19, 6-3
search histories 4-23, 5-16, 6-4
window settings 2-16
see also downloading
scrolling records 5-6
SDIs
configuring 2-18
creating 4-27
software option 2-9
Search History
after exchanging databases 3-4
clearing searches from 4-23, 6-1
complex search requests in 4-5
printing 4-22, 5-12
reusing searches from 4-22
running 4-24, 6-3
saving 4-23, 5-16, 6-4
search requests
clearing from Search History 4-23, 6-
1
combining terms in 4-6, 4-8
creating 3-6, 4-2
hyphens in 4-4
narrowing 4-29



operators in 4-6, 4-8
parentheses in 4-5
reusing 3-4, 4-22
selecting terms for
from retrieved records 5-6
from the Index 4-12, 4-30
from the Thesaurus 4-15-4-16,
4-30
truncation in 4-4, 4-30
wildcards in 4-4, 4-30

searching

after exchanging databases 3-4

Break button 4-6

examples 3-6, 4-2-779,4-3

fields 4-4

finding word variants 4-3

for suggested terms 4-11

hyphenated phrases 4-4

in a specific field 3-11, 4-9

in limit fields 4-10

in the Index 4-12

in the Thesaurus 4-15-4-16, 4-18—
4-20

multiple databases 4-29

numbers 4-3

operators 4-4

overview 3-6

parentheses 4-4

quotes 4-4

reusing previous searches 4-4

semi-colons 4-4

truncation and wildcards 4-3

see also Index; search history; Table
of Contents; Thesaurus

Select Fields

for printing 5-12, 5-13
for saving 5-15, 5-16, 5-17
for showing 5-2, 5-4

for printing 5-12
for saving 5-16
for showing 5-3
Warning 5-11
Selected Term Details 4-16
Selected Tree 4-18
selecting
databases 3-2
fields
for printing 5-12, 5-13
for saving 5-15, 5-16
for showing 5-2, 5-4
indexes 4-14, 6-4
records
for printing 5-9-5-10
for saving 5-9-5-10
for showing 5-3, 5-9-5-10
search terms
from retrieved records 5-6
from the Index 4-13
from the Thesaurus 4-16
software options 2-8
subheadings 4-20
type of application to install 2-6
type of installation 2-3
type of installation code 2-6
see also changing; marking
semi-colons 4-4
Separate Pages, print option 5-12
server addresses (ERL)
adding 2-7
deleting 2-7
editing 2-7
using existing 2-7
Show All Records 6-4
Show Selected Records 6-4
Show Selected Term 6-4
Show Selected Tree 6-4

Select Index 4-14, 6-4 showing
Selected Records fields, with hits 5-4, 5-14, 5-17
option options 5-2



vi

records 5-1-5-5
overview 3-6

Show Records Found button 4-2, 5-9

subsets
of fields 5-4
of records 5-3
see also viewing
SilverLinker
configuring 2-17
displaying links 5-8
SilverPlatter Information 1-3
Simultaneous Users option 2-9
Skip to Record option
for showing 5-3
software
options
Automatic Restart 2-9
Printable records 2-8
SDIs 2-9
Simultaneous Users 2-9
Timeout (minutes) 2-9
Update Magnetic Files 2-9
sorting records 6-5
SPLHA. see library holdings
Standalone Only applications 2-6
starting MacSPIRS 3-1
Startup screen 2-15
stopwords 4-12
subheadings 4-15, 4-20
suggested terms 4-11
Switch CFG file option 2-7
synonyms 4-15
synonyms. see Thesaurus

T
tables. see Fixed Font
Term Details 4-16
Thesaurus
broadening searches with 4-30
Explode Term 4-15
List of Permuted Terms 4-16

narrowing searches with 4-30
overview 3-9

Permuted Terms 4-16
Search List button 4-20

searching 4-15-4-16, 4-18-4-20

selected terms
deleting 4-20
getting details about 4-16
searching 4-20
viewing 4-19
Show Selected Tree 6-4
subheadings 4-15, 4-20
suggested terms 4-11
trees, displaying 4-17
Timeout (minutes) option 2-9
title screen 3-2, 3-3
trees, displaying 4-17
truncation 4-3, 4-4, 4-30

U

Update Magnetic Files option 2-9
User License Agreement 2-5
usernames, ERL 2-9

Vv
valid search requests 4-3
viewing
tables. see Fixed Font
see also showing
viewing. see showing

w

wildcards 4-4, 4-30

window settings, saving 2-16
WITH operator 4-6, 4-29
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